Introduction
Thank you for purchasing the Combustion Pressure Analysis Software. This user’s manual contains useful information about the functions and operating procedures of the software (for gasoline). To ensure proper use of the software, please read this manual thoroughly before beginning operation. After reading the manual, keep it in a convenient location for quick reference in the event a question arises.

Notes
• The contents of this manual are subject to change without prior notice as a result of improvements in the software’s performance and functions. Display contents illustrated in this manual may differ slightly from what actually appears on your screen.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have any questions or find any errors, please contact your nearest YOKOGAWA dealer.
• Copying or reproduction of all or any part of the contents of this manual without the permission of YOKOGAWA is strictly prohibited.

Trademarks
• Microsoft, Internet Explorer, Windows, Windows 7, Windows 8, Windows 8.1, and Windows 10 are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
• Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems Incorporated.
• In this manual, the ® and TM symbols do not accompany their respective registered trademark or trademark names.
• Other company and product names are trademarks or registered trademarks of their respective holders.

Revisions
• 1st Edition: December 2012
• 2nd Edition: February 2014
• 3rd Edition: February 2015
• 4th Edition: November 2015
• 5th Edition: October 2017
• 6th Edition: July 2019
Overview of This Manual

This manual consists of eight chapters and an appendix as described below.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System Configuration</td>
<td>Describes the hardware configurations needed for applications of the software.</td>
</tr>
<tr>
<td>2</td>
<td>Functions</td>
<td>Gives an overview of the combustion pressure analysis software functions and their flow of operations.</td>
</tr>
<tr>
<td>3</td>
<td>Common Operations</td>
<td>Describes installation, graph and window operations, and the various screens.</td>
</tr>
<tr>
<td>4</td>
<td>Monitor Function</td>
<td>Gives instructions on how to operate the Measurement and Monitor functions.</td>
</tr>
<tr>
<td>5</td>
<td>Combustion Pressure Analysis Function</td>
<td>Explains operations using the combustion pressure analysis function.</td>
</tr>
<tr>
<td>6</td>
<td>CSV Files</td>
<td>Provides a list of items that are saved to analysis data files.</td>
</tr>
<tr>
<td>7</td>
<td>Equations</td>
<td>Explains how each item is calculated.</td>
</tr>
<tr>
<td>8</td>
<td>Error Messages</td>
<td>Provides a list of error messages</td>
</tr>
<tr>
<td></td>
<td>Appendix</td>
<td>Provides input module information and FAQ.</td>
</tr>
</tbody>
</table>

Conventions Used in This Manual

- The following symbols and codes are used in the tables that describe the software’s settings and display data.
  
  **Data Type**
  
  C: Character string
  
  I: Integer
  
  F: Floating point

  **Size**

  For numerical data

  **10.2**

  - Total number of characters displayed (including the decimal point, +/- signs, e and E) (no. of bytes)
  - Number of digits displayed before the decimal point (no. of bytes)

  For character strings

  **38**

  - Maximum number of bytes

- When necessary for clarity, key names of the measuring instrument and items that appear on screen are set in boldface.
Contents

Chapter 1  System Configuration
  1.1  Hardware Configuration ................................................................. 1-1

Chapter 2  Functions
  2.1  Flow of Operation ................................................................. 2-1
  2.2  Measurement and Monitor Functions ................................................ 2-2
  2.3  Combustion Pressure Analysis Functions .............................................. 2-8

Chapter 3  Common Operations
  3.1  Installing and Starting the Software .................................................. 3-1
  3.2  Screens ............................................................................... 3-2
  3.3  Graph Operations ..................................................................... 3-5
  3.4  Window Operations ................................................................... 3-7
  3.5  Environment Settings .................................................................. 3-8

Chapter 4  Monitor Function Startup
  4.1  Starting the Setup Wizard ............................................................... 4-1
  4.2  DL850 Series/SL1000 Connection Settings (Setup screen) ....................... 4-2
  4.3  Setting Measurement Conditions (Measurement Conditions Setting screen) ........ 4-4
  4.4  Setting Filter Conditions (Filter Conditions Screen) ............................ 4-6
  4.5  Setting TDC Correction and the Calibration Factor .................................... 4-7
  4.6  Setting Channel Conditions for the Input Module (Detailed Setting Screen) ....... 4-10
  4.7  Setting Calculation Parameters (Parameter Settings Screen) .................. 4-13
  4.8  Displaying Measured Data ............................................................... 4-16
  4.9  Displaying Crank Angle Graphs ....................................................... 4-17
  4.10  Displaying Numeric Analysis Data Items ................................................ 4-18
  4.11  Saving Measured Data (Saving to wdf Files) ............................................. 4-19

Chapter 5  Combustion Pressure Analysis Function
  5.1  Loading Measured Data ................................................................. 5-1
  5.2  Saving/Loading Analysis Condition .................................................. 5-3
  5.3  Displaying Measured Data ............................................................... 5-4
  5.4  Setting the TDC Correction Value and Calibration Factor ......................... 5-5
  5.5  Combustion Pressure Analysis .......................................................... 5-6
  5.6  Displaying Crank Angle Graphs ....................................................... 5-7
  5.7  Displaying Cycle Graphs ................................................................. 5-9
  5.8  Displaying Numeric Analysis Data Items ............................................... 5-10
  5.9  Saving Analysis Data .................................................................... 5-11
  5.10 Setting Filter Conditions and Calculation Parameters .................................. 5-12

Chapter 6  CSV Files
  6.1  Format of Analysis Data ................................................................. 6-1

Chapter 7  Equations
  7.1  Explanation of Equations ................................................................. 7-1
Contents

Chapter 8 Error Messages
8.1 A List of Error Messages ........................................................................................................ 8-1

Appendix
Appendix 1 Relationship between Number of Mounted Modules and Maximum Number of Measurable Cycles ........................................................................................................ App-1
Appendix 2 Supported Modules .................................................................................................... App-2
Appendix 3 Frequently Asked Questions (FAQ) .......................................................................... App-3

Index
Chapter 1  System Configuration

1.1 Hardware Configuration

* The data that can be analyzed by the analysis function is the wdf data of the data measured on the DL850 series/SL1000.
** The Ethernet interface is an option on the SL1000.
*** WVF data saved with the DL750/WE7000 can also be analyzed offline.

PC System Requirements
OS: Windows 7, Windows 8, Windows 8.1, Windows 10
CPU: Core 2 Duo 2 GHz or higher
Memory: 2 GB or more
Hard disk: 2 GB or more of free space
USB port: 1 port or more (for USB license key)

For the DL850 Series/SL1000 (Monitor Function/Analysis Function)

- **Main Unit**
  DL850 series/SL1000
  (This application does not support synchronized operation of multiple SL1000s.)
  Memory length > (no. of cycles to acquire/save + 2) × 1 cycle data length
  For 4-cycle engines: 1 cycle data length = (360/res) × 2
  For 2-cycle engines: 1 cycle data length = (360/res)
  res: angular resolution (1, 0.5, 0.25, 0.1)

- **Input/Output Modules**
  701251 (High-Speed 1 MS/s, 16-Bit Isolation Module)
  However, [(RPM/60) × 360/res] < 1 MHz
  701261 and 701262 (Universal (Voltage/Tempt.) Modules)
  However, [(RPM/60) × 360/res] < 100 kHz
  500 Hz is the highest frequency for temperature measurement, but for higher frequencies, the same value are stored.
## 2.1 Flow of Operation

### Setup Wizard

<table>
<thead>
<tr>
<th>Setup</th>
<th>Measurement conditions</th>
<th>Filter conditions</th>
<th>TDC correction &amp; calibration factors</th>
<th>Parameter Settings screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set DL850 series or SL1000 interface conditions and module conditions</td>
<td>Select angular resolution, no. of measured cycles, and calculation data items when monitoring.</td>
<td>Filter ON/OFF, filter type, filter orders, etc.</td>
<td>Set the TDC correction value, calibration value factors, and trigger conditions, and check waveform conditions</td>
<td>Set engine and calculation condition specifications</td>
</tr>
</tbody>
</table>

### Monitor Function

<table>
<thead>
<tr>
<th>Monitor screen</th>
<th>Measurement screen</th>
<th>Save measured data</th>
<th>File selection screen</th>
<th>Calculation screen</th>
<th>Combustion pressure analysis</th>
<th>Save analysis data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display raw data, crank angle graphs, and numeric analysis data items</td>
<td>Display progress of acquisition of measured data and save measured data</td>
<td>Loading measured data (wdf/wvf files)</td>
<td>Select calculation data items and perform calculations</td>
<td>Display analysis results (raw data, crank angle graphs, cycle graphs, and numeric analysis data items)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Analysis Functions

- Setup screen
- Measurement Conditions screen
- TDC correction
- Calibration factors
- Trigger conditions
- Checking Waveforms
- TDC Correction Waveform
- Filter Condition Setting screen
- Setup Wizard
- Monitor Function
- Analysis Functions

**Chapter 2 Functions**
2.2 Measurement and Monitor Functions

Measurement Function
Using this software, you can enter channel (range, etc.) and trigger conditions on the DL850 series/SL1000, and perform measurement.

Trigger Conditions
You can set the trigger source (internal or external), trigger pattern, and level. Also, you can display the current waveform by using the Start waveform checking function, allowing you to check whether triggers activate per the specified trigger conditions.

Modules on Which Channel Conditions Can Be Set
You can enter the input coupling, range, bandwidth limit, invert waveform setting, and other settings on the following input modules.
• 701251 (High-Speed 1 MS/s, 16-Bit Isolation Module)
• 701261 and 701262 (Universal (Voltage/Temp.) Modules)
For a list of other supported input modules, see appendix 2.

Monitor Function
You can display the raw data and combustion pressure analysis results for one cycle’s worth of data.

Displaying Measured Data (Raw Data)
Displays filtered waveforms for (one cycle’s worth of) measured data before and after TDC correction.

Displaying Combustion Pressure Analysis Results
After performing calculations on data after TDC correction, you can display a crank angle graph of the results or the numeric analysis data items.

Note
• The TDC correction value is set in the TDC Correction and Calibration Factor Setting screen.
• Trigger conditions are set in the TDC Correction and Calibration Factor Setting screen.

• Displayable Analysis Data Items
The analysis data items that can be displayed in the crank angle graph and Numeric Analysis Data Item screen vary as follows depending on the selected monitor items.

<table>
<thead>
<tr>
<th>Monitor Item</th>
<th>Crank Angle Graph</th>
<th>Numeric Analysis Data Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td>Maximum cylinder pressure and the corresponding crank angle</td>
</tr>
<tr>
<td></td>
<td>Cylinder pressure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P-V graph</td>
<td>NMEP</td>
</tr>
<tr>
<td></td>
<td>Other signals</td>
<td>IMEP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PMEP</td>
</tr>
<tr>
<td>dP θ</td>
<td>Rate of cylinder pressure rise</td>
<td>Maximum rate of cylinder pressure rise and the corresponding crank angle</td>
</tr>
<tr>
<td>T θ</td>
<td>Cylinder gas temperature</td>
<td>Maximum cylinder gas temperature and the corresponding crank angle</td>
</tr>
<tr>
<td>dQ θ</td>
<td>Rate of heat release</td>
<td>Maximum rate of heat release and the corresponding crank angle</td>
</tr>
<tr>
<td>Q θ</td>
<td>Amount of heat release</td>
<td>Maximum amount of heat release and the corresponding crank angle</td>
</tr>
<tr>
<td></td>
<td>Combustion mass rate</td>
<td>Crank angle at combustion mass rate N1%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Crank angle at combustion mass rate N2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Crank angle at combustion mass rate N3%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Start point of combustion (point a)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>End point of combustion (point b)</td>
</tr>
</tbody>
</table>
2.2 Measurement and Monitor Functions

Saving Measured Data (Saving wdf Files)
You can acquire measured data of the number of cycles specified under number of cycles to acquire/save (during combustion) in the Measurement Conditions Setting screen and save the data in wdf format (Yokogawa proprietary format).

Settings Required for Measurement and Monitoring
Settings in the following setting screens must be entered before using the Measurement and Monitor functions.

- Setup (section 4.2):
  Set the number of strokes for the DUT, connected devices, and connected unit (DL850 series/SL1000)
- Measurement conditions (section 4.3):
  Set the angular resolution, number of cycles to acquire/save, and monitor items (dP θ /T θ /dQ θ /Q θ)
- Filter settings (section 4.4):
  Enter digital filter settings
- TDC correction and calibration factor settings (section 4.5):
  Set trigger conditions, calculate the TDC correction value, and enter absolute pressure correction and other settings
- Detailed module conditions (section 4.6):
  Set the input coupling, probe, bandwidth limit, and range
- Parameter settings (section 4.7):
  Set parameters for combustion pressure analysis calculations

When initially starting up the DL850 series/SL1000, the Setup Wizard appears and presents the above setting screens in order. The Setup Wizard will not appear again once settings have been entered initially (the setting conditions can be changed even after the Setup Wizard no longer appears upon startup).

Setup Settings
You can set the conditions for connection with the DL850 series/SL1000 and other parameters. If this first screen of the Setup Wizard does not appear, click Settings > Setup.

The following settings are available.

- Number of strokes: Select the number of strokes of the engine under test.
- Communication device: Select the method of communication between the PC running the software and the DL850 series/SL1000.
- Instrument search: Searches for connectable DL850 series/SL1000s.
- Units found: Displays a list of connectable DL850 series/SL1000s. Select an instrument to connect to, then click Done.
- Channel information: Displays information about the unit selected in the Units found list.

Setting Measurement Conditions
Set the following items.

- Angular resolution: Select the resolution for displaying graphs.
- Number of cycles to acquire/save
  During motoring: Set the number of cycles of measured data to acquire for calculation of the TDC correction value.
  During combustion: Set the number of cycles of measured data to save. Used when saving measured data.
- Monitor items: Select the monitor items. The item under analysis during monitoring varies depending on the selected monitor items.
2.2 Measurement and Monitor Functions

Filter Settings
You can apply filters to raw data. When applying filters, the first cycle’s worth of data is always dropped to cancel out the effect of signal rise. The remaining data is treated as the raw data and used for rotational offset correction, TDC correction, and combustion pressure analysis.

- Filter types
  None, Lowpass, Bandpass, Highpass
- Characteristics
  4th order (24 db/oct) butterworth
- Cutoff frequency
  • At 1 CA resolution, 7.2 order (times) of the number of revolutions (2%) to 72 order (times) (20%)
  • At 0.5 CA resolution, 14.4 order (times) of the number of revolutions (2%) to 144 order (times) (20%)
  • At 0.25 CA resolution, 28.8 order (times) of the number of revolutions (2%) to 288 order (times) (20%)
  • At 0.1 CA resolution, 72 order (times) of the number of revolutions (2%) to 720 order (times) (20%)
  * The percentage in parentheses is the ratio relative to the sampling frequency.
  \[% = \text{specified multiple} / (\text{360 degrees} / \text{angular resolution (1, 0.5, 0.25, 0.1)}) \times 100\]
  For example, to apply a low pass filter with a 1 kHz cutoff:
  At 3000 rpm (equivalent to 50 Hz),
  Cutoff = 1 kHz divided by 50 Hz = 20 times the rpm.

The TDC correction value is calculated for the filtered data, and all analyses are performed.

Parameter Settings
Enter values for the following parameters required for combustion pressure analysis.

1 Con-rod Length
2 Bore
3 Piston offset
4 Stroke
5 Clearance volume
6 Compression ratio
7 Method of absolute pressure correction
   (absolute pressure correction for each cycle, and absolute pressure correction for cycle average)
8 Start point of combustion
9 Number of data items for judging start point of combustion
10 End point of combustion
11 Number of data items for judging end point of combustion
12 Window of searching maximum rate of heat release
13 Ratio for judging angle of combustion mass rate
14 Value for judging misfire
15 Fuel consumption
16 Measured fuel consumption
17 Number of cylinders
18 Gas constant
19 Atmospheric temperature
20 Measured intake manifold temperature
21 Atmospheric pressure
22 Boost pressure
23 Measured intake manifold pressure
24 Suction volumetric efficiency
25 Revolutions per minute
26 Measured revolutions per minute
27 Specific gravity
28 Ratio of specific heat
TDC Correction and Calibration Factor Settings

• TDC Correction
You can perform TDC correction on data measured when motoring. Determines the offset values (calculated TDC correction value, number of engine cylinders, and cylinder-to-cylinder TDC correction value) between the TDC pulse position and the actual maximum pressure position using the specified number of cycles worth of acquired raw data. The offset values can also be entered manually. Note that the number of cycles to acquire is set in the Measurement Conditions screen as the number of cycles to acquire/save (when motoring).

• Absolute Pressure Correction, Calibration Factor (Conversion Coefficients), and Other Signals
For the signals input to each of the channels (1 to 16), you can set the type (cylinder pressure (up to 8 cylinders), intake manifold pressure, intake manifold temperature, mass fuel combustion, revolutions per minute, and other signals), range, starting/ending angle, coefficients for conversion to absolute cylinder pressure, and other parameters.

• Detailed Module Conditions
You can set the input coupling, probe, bandwidth limit, and range for the 701251 (High-Speed 1 MS/s 16-Bit Isolation Module) and 701261/701262 (Universal (Voltage/Temp.) Modules).

Correcting Rotational Offset and Calculating the TDC Correction Value
Since rotation pulse (TDC) signals are output once per revolution, there is an offset of 1/2 cycle for each single cycle of intake, compression, explosion, and exhaust. Therefore, the crank angle at the maximum point of pressure is determined from within one cycle’s worth of data, and if there is a pressure peak on the exhaust or intake stroke, the first 1/2 cycle’s worth of data is discarded.

If the crank angle at the maximum point of pressure < -180 CA or if +180 CA < the crank angle at the maximum point of pressure, the rotational offset is set to “yes.”

For the pressure data from the first cylinder during motoring, the software searches for the maximum pressure value after the rotational offset correction is performed, then determines the TDC position. It then calculates the offset from the TDC pulse position. This offset value is used for all analysis thereafter.
2.2 Measurement and Monitor Functions

- **TDC Correction Calculation Method**
  1. You can compute the average data for all cycles of the cylinder pressure data from the motoring data of the first cylinder.

Rotation pulse

Cylinder pressure data

Average cylinder pressure

2. Using 10 CA's worth of data before and after the maximum pressure point of the averaged cylinder pressure data, you can apply the least square method to compute the crank angle of maximum cylinder pressure $\theta_X$.

3. The TDC correction value can be determined using $\theta_X$. The TDC correction value is given as the amount of divergence of the maximum pressure point $\theta_X$ from the start of measurement, and a correction value is determined such that the position of $\theta_X$ is zero (CA). See the figure below.
2.2 Measurement and Monitor Functions

Method of Absolute Pressure Correction
You can convert measured cylinder pressure to absolute cylinder pressure. For example, cylinder pressure can be corrected so that the average cylinder pressure (on a per cycle or all cycle basis) of the crank angle range near BDC (which can be specified by the user) equals the atmospheric or intake manifold pressure. You can manually input atmospheric pressure (including boost pressure) or use measured intake manifold pressure.

- When using the per-cycle average value
  Pressure after absolute pressure correction = Pθin\(_n\) - Padj\(_n\) + Pxn
  Pxn: Atmospheric pressure (including boost pressure) or intake manifold pressure

- When using the all-cycle average value
  Pressure after absolute pressure correction = Pθin\(_n\) - Padj + Pxn
  Pxn: Atmospheric pressure (including boost pressure) or intake manifold pressure

Other Signals
You can specify signals that are not to be used for combustion pressure analysis. There are no physical units associated with these channels (channels you named “other signals”). Please consider these values to have whatever units are appropriate for your application. When converting voltage to physical values, enter the conversion coefficients (calibration factors) A and B for the equation \( y = Ax + B \). Also, note that absolute pressure correction is not performed on these signals.
2.3 Combustion Pressure Analysis Functions

**Analyzed Data**
Combustion pressure data saved in wdf or wvf format (both are Yokogawa proprietary formats) can be analyzed. The maximum number of cylinders that can be analyzed is 8.

**Loading Measured Data**
The software can load wdf files (Yokogawa proprietary format) containing cylinder data measured by the DL850 series/SL1000 from 4- or 2-cycle engines, or wvf files containing data measured by the DL750 or WE7000. After extracting a specified portion of this data (up to 800 cycles worth) for filter processing, rotational offset correction, and TDC correction, it can be analyzed.

**Filter Settings**
You can apply filters (None, Lowpass, Bandpass, or Highpass) to raw data. For filter processing and filter characteristics, see section 2.2.

**Parameter Settings**
You can set the calculation parameters used for combustion pressure analysis. For details on settings, see section 2.2.

**TDC Correction and Calibration Factor Settings**

- **TDC Correction**
  Correction values such as the calculated TDC correction value, number of engine cylinders, and cylinder-to-cylinder TDC correction value can be displayed. These correction values can be changed or recalculated.

- **Absolute Pressure Correction and Calibration Factors (Conversion Coefficients)**
  For the signals input to each of the channels (1 to 16), the type (cylinder pressure (up to 8 cylinders), intake manifold pressure, intake manifold temperature, mass fuel combustion, revolutions per minute, and other signals), range, starting/ending angle, coefficients for conversion to absolute cylinder pressure, and other parameters are displayed. These settings can be changed.

- **Other Signals (Channel Names)**
  You can specify signals to be excluded from combustion pressure analysis. Cycle-averaged values are displayed in the crank angle graph, the average value at each cycle is shown in the cycle graph, and the data can be saved in CSV format. TDC correction is based on the first cylinder.

For details on rotational offset correction, calculating the TDC correction value, absolute pressure correction, and other signals, see section 2.2.
2.3 Combustion Pressure Analysis Functions

Manually Input Data Items
You can change the settings and perform combustion pressure analysis of the items below.

Settings Related to TDC Correction and Calibration Factor
- TDC correction values
- Conversion coefficients (calibration factors A and B)
- Unused channels
- Starting angle of correction interval
- Ending angle of correction interval

Settings Related to Parameters
- Con-rod length
- Fuel consumption
- Bore
- Gas constant
- Piston offset
- Atmospheric temperature
- Stroke length
- Atmospheric pressure
- Clearance volume
- Suction volumetric efficiency
- Compression ratio
- Revolutions per minute
- Method of absolute pressure correction
- Specific gravity
- Number of data items for judging start point of combustion
- Ratio of specific heat
- Starting angle of correction interval
- Boost pressure
- Ending angle of correction interval
- Ratio for judging angle of combustion mass rate (3 locations)
- Unused channels
- Value for judging misfire
- Number of data items for judging end point of combustion
- Window for searching maximum rate of heat release

Selecting Combustion Pressure Analysis Data Items
You can select the items with which to perform combustion pressure analysis from the ones below.

Crank Angle Graph
- Cylinder pressure
- Rate of cylinder pressure rise
- Amount of heat release
- Rate of heat release
- Combustion mass rate
- Cylinder gas temperature
- Polytropic index
- Other signals

P-V Graph
- Cylinder pressure - Piston displacement graph
- Logarithmic cylinder pressure - Logarithmic piston displacement graph

Cycle Graph
- Maximum cylinder pressure
- Averaged maximum cylinder pressure of all cylinders
- Average crank angle at maximum cylinder pressure
- Averaged crank angle at maximum cylinder pressure of all cylinders
- Maximum rate of pressure rise
- Averaged maximum rate of cylinder pressure rise of all cylinders
- Crank angle at maximum rate of cylinder pressure rise
- Averaged angle at maximum rate of cylinder pressure rise of all cylinders
- NMEP
- Averaged NMEP of all cylinders
- IMEP
- Averaged IMEP of all cylinders
- PMEP
- Averaged PMEP of all cylinders
- Maximum amount of heat release
- Crank angle at maximum amount of heat release
- Maximum rate of heat release
- Crank angle at maximum rate of heat release
- Crank angle at combustion mass rate N1 %
- Crank angle at combustion mass rate N2 %
- Crank angle at combustion mass rate N3 %
- Other signals
2.3 Combustion Pressure Analysis Functions

Analysis Data Items Graphed in 3D

- Cylinder pressure
- Amount of heat release
- Combustion mass rate
- Polytropic index
- Rate of cylinder pressure rise
- Rate of heat release
- Cylinder gas temperature
- Other signals

Numeric Analysis Data Items

When performing combustion pressure analysis, you can display a list of the following items.

- Piston displacement (m³)
- Averaged maximum cylinder pressure of all cycles and cylinders (kPa)
- Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)
- Averaged NMEP of all cycles and cylinders (kPa)
- Averaged IMEP of all cycles and cylinders (kPa)
- Averaged PMEP of all cycles and cylinders (kPa)
- Minimum IMEP of all cycles and cylinders (kPa)
- LNV of IMEP of all cycles and cylinders (%)
- Average cylinder pressure across correction interval (When calculating the average pressure of the crank angle range determined from the all-cycle average and applying the result to all cycles)
- Average, standard deviation (kPa), and rate of change (%) of the maximum cylinder pressure
- Average, standard deviation (kPa), and rate of change (%) of the maximum rate of cylinder pressure rise
- Average, standard deviation (kPa), and rate of change (%) of NMEP
- Average, standard deviation (kPa), rate of change (%), minimum (kPa), and LNV (%) of IMEP
- Average, standard deviation (kPa), and rate of change (%) of PMEP
- Rate of misfire (%)
- Average, standard deviation (°C), and rate of change (%) of the maximum cylinder gas temperature
- Average, standard deviation (J/deg), and rate of change (%) of the maximum rate of heat release
- Average, standard deviation (J), and rate of change (%) of the maximum amount of heat release
- Average, standard deviation (CA), and rate of change (%) of the angle at combustion mass rate N1%
- Average, standard deviation (CA), and rate of change (%) of the angle at combustion mass rate N2%
- Average, standard deviation (CA), and rate of change (%) of the angle at combustion mass rate N3%
- Average start point of combustion (point a) (CA)
- Average end point of combustion (point b) (CA)
Performing Combustion Pressure Analysis and Displaying Results

• Performing Calculations
You can perform calculation and analysis on the selected combustion pressure analysis data items based on the manually input data item settings (such as calculation parameters, TDC correction value, and interval of absolute pressure correction).

• Displaying Combustion Pressure Analysis Results
After performing calculations, you can select one calculated item and display a graph (crank angle graph or cycle graph) or display numeric analysis data items in a list. Note that manually input data items and analysis data items can be entered or reselected so that additional calculations can be performed.

Saving Analysis Data
You can save data of the following items in CSV format (.csv files). Raw data cannot be saved.
• Test Information
  Test date/Data name/Testing personnel/Department/Test name/Engine type/Serial No./Place of test/Test bench type/Comments
• Manually Input Data Items (for details, see above).
• Numeric Analysis Data Items (for details, see above).
• Crank Angle Graph Data
• Cycle Graph Data
• Analysis Data for Other Signals
• Measured Intake Manifold Pressure, Intake Manifold Temperature, Fuel Consumption, and Revolutions per Minute (only when measured)

Saving Analysis Data (of a Specified Range of Cycles)
For the seven items below, the crank angle graph data from a specified range of cycles can be saved in CSV format (as .csv files).
• Cylinder pressure
• Rate of cylinder pressure rise
• Amount of heat release
• Combustion mass rate
• Logarithmic cylinder pressure
• Cylinder gas temperature
• Rate of heat release

Loading and Saving Analysis Conditions
The following analysis conditions can be saved (as .ecp files) in text format and loaded.
• TDC correction value
• Interval of absolute pressure correction
• Coefficients for conversion to physical values (calibration factors)
• Filter setting conditions
• Calculation execution items
• Screen layout
• Number of cylinders
• Calculation parameters
• Analysis graph display conditions
3.1 Installing and Starting the Software

Installing the Software
Use the setup program on the CD to install (set up) the Combustion pressure analysis software.
Run the file, CD Drive:/Setup.exe.
You must log in as the administrator to perform the installation. For details, see the separate user’s manual.

Starting the Program
Connect the hardware license key to a USB port.
Click the icon for the combustion pressure analysis software on the desktop. The Combustion pressure analysis software starts.

Uninstallation
Select "Combustion Pressure Analysis Software" from "Programs and Features" on "Control Panel".
Click Uninstall.
3.2 Screens

**Startup Screen**

- Monitor function active
- Distinguishes between raw data (v) and corrected data (v)

**Differences between the Monitor and Analysis Screens**

Monitor screen
- Displays “Monitor”

Analysis screen
- Displays the file name

**Menu Bar and Toolbar**

1. Saves measured data
2. Saves bitmap data
3. Performs calculations
4. Moves the cursor
5. Setup Wizard
### 3.2 Screens

<table>
<thead>
<tr>
<th>Menu Bar</th>
<th>Toolbar</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1 File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load measured data</td>
<td>*1, 2</td>
<td>Loads wdf/wvf files containing data measured by the DL850 series, SL1000, DL750, or WE7000.</td>
</tr>
<tr>
<td>Save measured data</td>
<td>*1</td>
<td>Acquires the specified number of cycles worth of data measured during monitoring and saves it to a file (wdf data).</td>
</tr>
<tr>
<td>Save analysis data</td>
<td>*2</td>
<td>Saves data analyzed with the analysis functions to a file (csv format).</td>
</tr>
<tr>
<td>Load analysis conditions</td>
<td>*1, 2</td>
<td>Loads files to which test information, manually input data items, calculation data items, and other items were saved.</td>
</tr>
<tr>
<td>Save analysis conditions</td>
<td>*1, 2</td>
<td>Saves test information, manually input data items, calculation data items, and other items.</td>
</tr>
<tr>
<td>Setup Wizard</td>
<td>*2</td>
<td>Displays the Monitor and Setup screens. You can use the wizard when nothing is displayed in the combustion pressure analysis software window.</td>
</tr>
<tr>
<td>Close</td>
<td>-</td>
<td>Closes the active window and all other associated windows.</td>
</tr>
<tr>
<td>Exit application</td>
<td>-</td>
<td>Exits the program.</td>
</tr>
<tr>
<td><strong>2 Edit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>3 View</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured data</td>
<td>*1, 2</td>
<td>Displays measured (raw) data before or after TDC correction.</td>
</tr>
<tr>
<td>Crank angle graph</td>
<td>*1, 2</td>
<td>Displays a crank angle graph.</td>
</tr>
<tr>
<td>Cycle graph</td>
<td>*1, 2</td>
<td>Displays a cycle graph (only when using the analysis function).</td>
</tr>
<tr>
<td>Numeric analysis data item</td>
<td>*1, 2</td>
<td>Displays a list of analysis results</td>
</tr>
<tr>
<td><strong>4 Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setup</td>
<td>*1</td>
<td>Displays the Setup screen (the first screen of the Setup Wizard). You can set the conditions for connection with the DL850 series / SL1000 and other parameters.</td>
</tr>
<tr>
<td>Measurement conditions</td>
<td>*1</td>
<td>Sets measurement conditions (angular resolution, number of cycles to acquire/save, etc.).</td>
</tr>
<tr>
<td>Filter</td>
<td>*1, 2</td>
<td>Sets filter conditions.</td>
</tr>
<tr>
<td>TDC correction and calibration factor setting</td>
<td>*1, 2</td>
<td>Sets TDC correction and the calibration factor.</td>
</tr>
<tr>
<td><strong>5 Calculation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set parameters</td>
<td>*1, 2</td>
<td>Sets the parameters used for performing combustion pressure analysis.</td>
</tr>
<tr>
<td>Calculate</td>
<td>*2</td>
<td>Selects the items of analysis and performs the calculation.</td>
</tr>
<tr>
<td><strong>6 Monitor</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start</td>
<td>*1</td>
<td>Starts the monitor.</td>
</tr>
<tr>
<td>Stop</td>
<td>*1</td>
<td>Stops the monitor.</td>
</tr>
</tbody>
</table>

*1 Available when using the Monitor function  
*2 Available when using the Combustion Pressure Analysis function
### 3.2 Screens

<table>
<thead>
<tr>
<th>Menu Bar</th>
<th>Toolbar</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D graph</td>
<td>![3D icon]</td>
<td>Enters 3D graph related settings.</td>
</tr>
<tr>
<td>Axis range</td>
<td>![Axis icon]</td>
<td>Sets the scales of the X and Y axes.</td>
</tr>
<tr>
<td>Displayed channels</td>
<td>![Channel icon]</td>
<td>Selects the channels to be displayed in the graph.</td>
</tr>
<tr>
<td>Cycles</td>
<td>![Cycle icon]</td>
<td>Sets the number of cycles to display in the crank angle graph.</td>
</tr>
<tr>
<td>Graph colors</td>
<td>![Color icon]</td>
<td>Sets the colors of the graph.</td>
</tr>
<tr>
<td>8 Window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Tile</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Arrange icons</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Minimize</td>
<td>![Minimize icon]</td>
<td></td>
</tr>
<tr>
<td>Restore</td>
<td>![Restore icon]</td>
<td></td>
</tr>
<tr>
<td>9 System</td>
<td>Environment settings</td>
<td>Sets the operating conditions.</td>
</tr>
<tr>
<td>10 Help</td>
<td>![Help icon]</td>
<td>Opens the user’s manual in pdf format.</td>
</tr>
<tr>
<td>About ECP</td>
<td>-</td>
<td>Displays the software version.</td>
</tr>
<tr>
<td>11</td>
<td>![Arrow icon]</td>
<td>Moves the cursor to the right or left when displaying a graph.</td>
</tr>
<tr>
<td>12</td>
<td>![Print icon]</td>
<td>Saves the image as a bitmap file.</td>
</tr>
</tbody>
</table>

*1 Available when using the Monitor function  
*2 Available when using the Combustion Pressure Analysis function  
*3 To view PDF files, you need Adobe Reader.
3.3 Graph Operations

If you right-click on a window displaying a graph, the following shortcut menu appears, and the following operations can be performed.

**Monitor screen**

- **Measured data:**
  Opens a new window displaying a crank angle graph of raw data (data after TDC correction).
- **Crank angle graph:**
  Opens a new window displaying a crank angle graph of selected analysis data items.
- **Cycle graph:**
  Opens a new window displaying a cycle graph of selected analysis data items. Note that this operation is not available when using the Monitor function.
- **Numeric analysis data items:**
  Opens a window displaying calculated numeric analysis results.
- **3D graph:**
  Displays the Graph Dimension Settings screen. Selects 2D or 3D graph, and sets 3D graph conditions (when displaying a crank angle graph or 3D analysis graph). The range of cycles extracted from the raw data is set as the maximum range, crank angle data is extracted every number of cycles specified by “by,” and the data is displayed in a 3D graph (displays up to 20 waveforms). Note that this operation is not available when using the Monitor function.

**Analysis screen**

- **Axis range:**
  Displays the Axis Settings screen. You can set a fixed value for the X and Y axes, or choose Autoscale. These settings are entered for each graph.

- **Display channels:**
  Displays a pull-down menu for display channels. This setting is entered for each graph.
3.3 Graph Operations

- **Cycles:**
  Displays a setting screen for the **Displayed Cycles**. These settings are entered for each graph.

  ![Displayed Cycles](Image)

  - **AVE:** Displays a cycle average crank angle graph
  - **ALL:** Displays superimposed crank angle graphs of all cycles
  - **Other:** Displays a crank angle graph of the specified cycles

- **Graph colors:**
  Displays the **Graph Color Setting** screen. These settings are entered for each graph.

  ![Graph Color Settings](Image)

  Clicking Background, Grid, Axes, Cursor, or Graph displays a Color window where you can set the color.

  ![Color](Image)

- **Move cursor:**
  Reads the cursor position directly. Cursors can be moved from left to right in units of angular resolution using the following buttons.

  - ⬅️: Fast left cursor
  - ←: Left cursor
  - →: Right cursor
  - ➡️: Fast right cursor

- **Displaying the Mouse Pointer Position:**
  When the mouse is moved over a graph, the X and Y value of the current position is displayed on the graph.

- **Save screen to BMP file:**
  Click to save the active graph window as a bitmap file.

- **Show help:**
  Click Help > Help, or click the button to display the user’s manual in pdf format. You can also click Help > About ECP to display version information.
3.4 Window Operations

Functions
The window operations below can be performed. You can select these from the menus bar Window, or click the corresponding icon.

Cascade: Arranges all open windows in a cascading fashion.
Tile: Arranges all open windows so that they do not overlap.
Arrange icons: Arranges minimized icons.
Minimize: Minimizes all windows accessing the same data.
Minimizes all real time monitor function windows.
Restore: Restores all minimized windows that were accessing the same data.
Restores all minimized real time monitor function windows.

• Closing Windows
You can close a window with either of the procedures below.

• Click the close button (×) in the upper right corner of the active window.
  The active window closes.
• On the menu bar, click File > Close.
  All windows accessing the data files used for the current window are closed. The current analysis results are discarded at the same time.
3.5 Environment Settings

Click System > Environment settings

Functions
You can change the operating conditions of the combustion pressure analysis software. Edit settings in the screen that is displayed when you click System > Environment settings.

Setting/Display Data
Combustion pressure analysis software operating conditions
- Startup in Analysis mode: Select to bypass the Setup Wizard and display the file loading screen for the combustion pressure analysis.
- Show wizard upon startup: Select to start the Setup Wizard.

Note that the operation differs depending on the Startup in Analysis mode setting as follows.

<table>
<thead>
<tr>
<th>Startup in Analysis Mode</th>
<th>Show Wizard upon Startup</th>
<th>Operation upon Startup</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>ON</td>
<td>Displays the combustion pressure analysis screen</td>
</tr>
<tr>
<td>ON</td>
<td>OFF</td>
<td>Displays the combustion pressure analysis screen</td>
</tr>
<tr>
<td>OFF</td>
<td>ON</td>
<td>Opens the Setup Wizard</td>
</tr>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>Opens a startup confirmation message(^1) or displays the monitor screen(^2)</td>
</tr>
</tbody>
</table>

\(^1\) If the condition of the hardware upon startup differs from the previous session
\(^2\) If the condition of the hardware upon startup is the same as the previous session

Button Operations
OK: Enters set conditions and exits. To change conditions, you must restart the combustion pressure analysis software.
Cancel: Discards setting conditions and exits.
4.1 Starting the Setup Wizard

When Starting the Combustion Pressure Analysis Software
Perform one of the following operations.

- A **startup confirmation message** appears immediately after installation or if the previous measurement setting conditions and hardware conditions (connection conditions) are different.
- If the measurement setting conditions match the previous conditions, the Monitor screen opens and monitoring starts.
- If you selected Start up in Analysis Mode in the Environment Settings screen, a **file selection** screen opens.

**Setup Wizard**
The Setup Wizard takes you through the various setting screens, in order, that are described in sections 4.2 through 4.7. Using the wizard allows you to systematically enter all of the settings required for measurement and monitoring. For details on each setting screen, see sections 4.2 to 4.7.

Note that you can display the Setup screen (the first screen of the wizard) by clicking **Settings > Setup**.

Click No when performing combustion pressure analysis or when not using the Measurement Setup Wizard.

**Note**

- To perform only analysis with data saved to the PC, click No.
- If you select the Display wizard on startup check box, the setup wizard will always appear upon startup. However, the wizard will not appear if you specify to start up for combustion pressure analysis in the system settings.
- The **Show wizard upon startup** setting can be changed in the environment settings screen (section 3.5).
4.2 DL850 Series/SL1000 Connection Settings (Setup screen)

Click Settings > Setup, or click [].

Functions
- Sets the interface for communication between the SL1000 or DL850 series and the PC, as well as various conditions for the interface.
- Searches for measurement instruments connected to the PC through the specified interface.
- If you click one of the measurement instruments found, a list of input modules mounted on that measurement instrument is generated.
4.2 DL850 Series/SL1000 Connection Settings (Setup screen)

Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Measuring Instrument Selection</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>No. of Strokes</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Communication Device</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DL850 series: Serial No.</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>DL850 series: IP Address</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Group ID</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>SL1000: Unit Address</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>SL1000: IP Address</td>
<td>Prev. value</td>
<td>1</td>
<td>16</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>9</td>
<td>Connected Units</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>10</td>
<td>Channel Information</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Channels</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Modules</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

2. No. of Strokes: Select 2-cycle or 4-cycle engine.
3. Communication Device: Select Ethernet or USB.
4. Instrument Search DL850 series:
   - Serial No.: If you select USB, set the DL850 series serial number. For the serial number, see the install manual (IM 720340-04EN.)
   - IP address: If you select Ethernet, set the DL850 series IP address.
5. SL1000 Group ID: Select an area group number for the SL1000 from 0 to F and Not Specified. If you select “Not Specified,” all units on the communication device will be searched for.
6. Unit Address: Select Auto Search or Specify Address.
   If you select Specify Address, enter an IP address.
7. Connected Units: Icons are displayed for the instruments that are found in the search.
   If you click one of the found instruments, a list of input modules installed in the instrument will be created.
   If the same units are not present, or if the module list is not the same the next time you start the software, the Setup Wizard will appear.

Button Operations

Search: Searches for DL850 series or SL1000s based on specified conditions, and displays an icon for each connected unit found. For SL1000, the units displayed are the master units for their group.

Back: Cannot be selected.

Next: Saves settings and moves to the Measurement Conditions Setting screen.

Exit: Saves settings and closes the screen.

Cancel: Discards settings and closes the screen.
4.3 Setting Measurement Conditions
(Measurement Conditions Setting screen)

Click Settings > Measurement conditions, or click  

Functions
You can set the following items.

- Angular resolution: Select a horizontal axis resolution for graphs of 1 CA, 0.5 CA, 0.25 CA, or 0.1 CA.
- Number of cycles to acquire/save
  During motoring: Sets the number of cycles of measured data to acquire for calculation of the TDC correction value.
  During combustion: Sets the number of cycles of measured data to save. Used when saving measured data.
- Select monitor items: Select the monitor items. The analysis data items that can be displayed in the crank angle graph and Numeric Analysis Data Item screen vary as in the table below depending on the selected monitor items.

Note
The settings take effect after monitoring is resumed.

<table>
<thead>
<tr>
<th>Monitor Items</th>
<th>Crank Angle Graph</th>
<th>Numeric Analysis Data Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Cylinder pressure</td>
<td>Maximum cylinder pressure and the corresponding crank angle</td>
</tr>
<tr>
<td></td>
<td>P-V graph</td>
<td>NMEP</td>
</tr>
<tr>
<td></td>
<td>Other Signals</td>
<td>IMEP</td>
</tr>
<tr>
<td></td>
<td>dP θ*</td>
<td>PMEP</td>
</tr>
<tr>
<td></td>
<td>Rate of cylinder pressure rise</td>
<td>Maximum rate of cylinder pressure rise and the corresponding crank angle</td>
</tr>
<tr>
<td></td>
<td>T θ*</td>
<td>Cylinder gas temperature and the corresponding crank angle</td>
</tr>
<tr>
<td></td>
<td>dQ θ*</td>
<td>Rate of heat release and the corresponding crank angle</td>
</tr>
<tr>
<td></td>
<td>Q θ*</td>
<td>Maximum amount of heat release and the corresponding crank angle</td>
</tr>
</tbody>
</table>
|               | Combustion mass rate    | Crank angle at combustion mass rate N1%
  Crank angle at combustion mass rate N2%
  Crank angle at combustion mass rate N3%
  Start point of combustion (point a)
  End point of combustion (point b)

* The analysis data items when no monitor items are selected (None) are also targeted for analysis/display.
4.3 Setting Measurement Conditions (Measurement Conditions Setting screen)

Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Angular resolution</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Number of cycles to acquire/save</td>
<td>Prev. value</td>
<td>1</td>
<td>3</td>
<td>2</td>
<td>See Appendix 1</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Select monitor items</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Button Operations

Back: Saves settings and returns to the Setup screen.
Next: Saves settings and moves to the Filter Conditions screen.
Exit: Saves settings and closes the screen.
Cancel: Discards settings and closes the screen.
4.4 Setting Filter Conditions (Filter Conditions Screen)

Click Settings > Filters, or click .

Functions
- You can perform digital filter processing on raw data. If the raw data has already been displayed and filter settings are changed, filters are automatically reapplied and the display is updated. However, this does not affect current analysis results. All analysis results are discarded, and any currently displayed analysis results windows (crank angle graphs or numeric analysis data items) are forcibly closed. After recalculation, display the analysis results window.
- You can select a filter of None, Lowpass, Bandpass, or Highpass.
- The filter function is a 4th order Butterworth (24 db/oct).
- The cutoff frequency is set in numbers of orders (multiples) since data acquisition uses synchronization with the rotation pulse.
- When filters are applied, any TDC correction and combustion pressure analysis performed thereafter is done on filtered data.

Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Filter type</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Cutoff</td>
<td>Prev. value</td>
<td>F</td>
<td>6.1</td>
<td>7.2</td>
<td>720</td>
</tr>
</tbody>
</table>

1 Filter type: Select a filter of None, Lowpass, Bandpass, or Highpass.
2 Cutoff: At 1 CA resolution, 7.2 order (times) to 72 order (times) of the number of revolutions
   - At 0.5 CA resolution, 14.4 order (times) to 144 order (times) of the number of revolutions
   - At 0.25 CA resolution, 28.8 order (times) to 288 order (times) of the number of revolutions
   - At 0.1 CA resolution, 72 order (times) to 720 order (times) of the number of revolutions

Button Operations
- Back: Saves settings and returns to the Measurement Conditions screen.
- Next: Saves settings and moves to the TDC Correction and Calibration Factor screen.
- Exit: Saves settings and closes the screen.
- Cancel: Discards settings and closes the screen.
4.5 Setting TDC Correction and the Calibration Factor

Displays the Waveform Checking screen.

Acquires data of the number of cycles specified under "number of cycles to acquire/save" in the Measurement Condition Setting screen (opened by clicking Settings > Measurement Conditions) and calculates the correction value.

Click Settings > TDC correction and calibration factor, or click .

**Functions**

- The TDC correction value can be calculated using one cycle’s worth of all-cyclen averaged motoring data from cylinder 1 (P1). The calculated TDC correction value is added to the difference in angle between cylinders according to the specified number of cylinders (for example at 4 cycles and 4 cylinders) in the following manner: 0 + calculated TDC correction value, 180 + calculated TDC correction value, 360 + calculated TDC correction value, 540 + calculated TDC correction value, then the cylinder-to-cylinder TDC correction value is automatically set. You can also set the cylinder-to-cylinder TDC correction values manually (excluding P1).

- Signal assignments can be entered. You can assign channels to cylinder pressure (up to eight cylinder’s worth), intake manifold pressure, intake manifold temperature, fuel consumption, rpm, and other signals.

- The cylinder pressure signals undergo TDC correction per the specified TDC correction value.
4.5 Setting TDC Correction and the Calibration Factor

- Cylinder pressure measurements take place in the cylinder’s firing order, with the assumption that all signals are assigned to contiguous channels starting with channel 1.
- You can specify channels to be excluded from combustion pressure analysis.
- If raw data is already displayed, settings are automatically applied and the display is updated. However, this does not affect current analysis results. When changing these settings, all previously calculated analysis results are discarded, and any currently displayed analysis results windows (crank angle graphs or numeric analysis data items) are forcibly closed. After recalculation, display the analysis results window.
- You can enter trigger condition settings. With CH level triggers, you can enter level settings with the waveform checking function. If the trigger does not activate properly, you can use a manual trigger to check the waveform.
- You can acquire data for calculating the TDC correction value (data acquisition when motoring), and use that waveform for obtaining TDC correction results.

### Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calculated TDC Correction Value</td>
<td>Calculated value</td>
<td>F</td>
<td>7.2</td>
<td>*1</td>
<td>*2</td>
</tr>
<tr>
<td>2</td>
<td>Number of Cylinders</td>
<td>Prev. value</td>
<td>I</td>
<td>2.0</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>Cylinder-to-cylinder TDC Correction</td>
<td>Calculated value</td>
<td>F</td>
<td>7.2</td>
<td>*1</td>
<td>*3</td>
</tr>
<tr>
<td>4</td>
<td>Ch Selection</td>
<td>None</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Channel Name</td>
<td>None</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Interval of Absolute Pressure Correction</td>
<td>Prev. value</td>
<td>F</td>
<td>7.2</td>
<td>*1</td>
<td>*2</td>
</tr>
<tr>
<td>7</td>
<td>A</td>
<td>Prev. value</td>
<td>F</td>
<td>8.2</td>
<td>1</td>
<td>999999.99</td>
</tr>
<tr>
<td>8</td>
<td>B</td>
<td>Prev. value</td>
<td>F</td>
<td>8.2</td>
<td>1</td>
<td>999999.99</td>
</tr>
<tr>
<td>9</td>
<td>Trigger conditions</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Edge</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>CH select</td>
<td>Prev. value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Level</td>
<td>Prev. value</td>
<td>F</td>
<td>5.2</td>
<td>-999.99</td>
<td>999.99</td>
</tr>
</tbody>
</table>

*1: 4 cycles = -360; 2 cycles = -180
*2: 4 cycles = -359.9; 2 cycles = -179.9
*3: 4 cycles = -1079.9; 2 cycles = -539.9

1 Calculated TDC Correction Value:
Displays the TDC correction values calculated using the average of all cycles of the first cylinder (P1). The value can also be entered manually. When the OK button is used, this value is rounded to the angular resolution and applied to each channel.

2 Number of Cylinders:
Specified for automatic calculation of the cylinder-to-cylinder correction value. If the value is changed, click the Calculate button to recalculate the results.

3 Cylinder-to-cylinder TDC Correction:
The calculated TDC correction value is added to the difference in the crank angle. For example, with a 4-cycle engine:
- 4 cylinders = 180 CA, 6 cylinders = 120 CA, and 8 cylinders = 90 CA. You can also set the value manually (excluding P1).

4 Ch Selection
Selected channels are targeted for combustion pressure data measurement and analysis, and for saving in csv format.
5 Channel Names:
Signals are assigned to channels 1 through 16. Select the signal type from the
options below.
- P1 to P8: Cylinder pressure in the order of firing
- Pitk: Intake manifold pressure
- Gfuel: Fuel consumption
- Ne: Revolutions per minute
- Td: Intake manifold temperature
- Other: Other Signals
For signals other than P1 through P8, TDC correction is performed based on the
1st cylinder.
This measured data can be used when measuring intake manifold pressure,
fuel consumption, revolutions per minute, and intake manifold temperature, and
performing analysis. The average value at each cycle can be saved to a .csv file. 
Other signals can be displayed in a crank angle graph or cycle graph, and that
graphical data can be saved in CSV format.

7 A, B:
The measured voltage signals are converted to physical values using the equation
\[ y = Ax + B \]

9 Trigger conditions:
Select External trigger or CH level trigger. For external triggers, select rising or
falling edge. For CH level triggers, specify a channel number, level, and edge.

Button Operations
Start measurement of TDC correction data:
Measures motoring data and calculates the TDC correction value.
The measured number of cycles is the value specified for the number
of cycles during motoring in the measurement condition settings. A
progress bar is displayed during measurement.
Start waveform checking:
Opens the Waveform checking screen. You can check whether the
range and trigger conditions are set correctly. Note that if trigger
conditions are not set correctly, a waveform is not displayed. If you
click Manual trigger a trigger is forcibly activated, allowing you to
check the waveform. Reenter the range and trigger conditions, making
sure they are correct. If you click the Start waveform checking key,
it changes to the Stop waveform checking key. Waveform checking
involves repeating cycles of data measurement and waveform display.
After checking the waveforms, you can change the display channel and
move the cursor on the last-displayed waveform to check values.

Manual trigger: Opens the Waveform Checking screen. Forcibly activates a trigger and
displays the waveform on screen.
Detailed settings: For the 701251 and 701261/701262 modules, moves to the Detailed
Settings screen.
Back: Saves settings and returns to the Filter Conditions screen.
Next: Saves settings and moves to the Parameter Settings screen.
Exit: Saves settings and closes the screen.
Cancel: Discards settings and closes the screen.
4.6 Setting Channel Conditions for the Input Module (Detailed Setting Screen)

Click Settings > Channel conditions in the TDC Correction and Calibration Factor screen > Detailed settings

**Setting/Display Data**

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Units</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel number</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Input coupling</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Probe</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Bandwidth limit</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Range</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Invert waveform</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

2 Input coupling: Sets the coupling information of the signal to connect.
Select AC, DC, or GND. Default value: DC

3 Probe information: Select 1:1, 10:1, 100:1, 1000:1, 10A:1, or 100A:1.

4 Bandwidth limit: Select a limit from the box.
Select 400 Hz, 4 kHz, 40 kHz, or Full.

5 Range: Select a limit from the box.
The setting range varies depending on the probe information.
Range is displayed using V/div and voltage range.

V/div Voltage range
2 mV/div to 40 V/div 10 mV to 200 V (1:1)
20 mV/div to 400 V/div 100 mV to 2 kV (10:1)
200 mV/div to 4 KV/div 1 V to 20 kV (100:1)
2 V/div to 40 KV/div 10 V to 200 kV (1000:1)
20 mA/div to 400 A/div 100 mA to 2 kA (10 A:1 V 0.1 V/A)
200 mA/div to 4 KA/div 1 A to 20 kA (100 A:1 V 0.01 V/A)

6 Invert waveform: Selects whether or not to invert the waveform on screen.

**Button Operations**
Previous channel: Saves settings and moves to the previous detailed conditions screen.
Next channel: Saves settings and moves to the next detailed conditions screen.
Exit: Saves settings and closes the screen.
Cancel: Discards settings and closes the screen.
4.6 Setting Channel Conditions for the Input Module (Detailed Setting Screen)

Click Settings > Channel conditions in the TDC Correction and Calibration Factor screen > Detailed settings

**Setting/Display Data**

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Units</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel number</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Input coupling</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Probe</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Bandwidth limit</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Range</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Invert waveform</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

2. **Input coupling:** Select AC, DC, TC, or GND.

3. **Bandwidth limit:** If voltage is selected under input coupling, select 40 Hz, 400 Hz, 4 kHz, or Full, and if thermocouple (TC) is selected, select 2 Hz, 8 Hz, 30 Hz, or Full.

4. **Range:** Select a limit from the box. If the input coupling is AC, DC, or GND, select from 10 mV/div to 40 V/div (50 mV to 200 V), and if TC, select K, E, J, T, L, U, N, R, S, B, W, or iron doped gold/chromel (Au7Fe).

5. **Invert waveform:** Selects whether or not to invert the waveform on screen. Can only be set if AC, DC, or GND is selected under input coupling. Can be set if TC is selected.

6. **TC Units:** If the input coupling is TC, select °C, K or F.

7. **RJC:** Select RJC.

8. **Burnout:** Selects whether or not to perform a burnout check. Can only be set if TC is selected under input coupling. Cannot be set if AC, DC, or GND is selected.

**Button Operations**

- **Previous channel:** Saves settings and moves to the previous detailed conditions screen.
- **Next channel:** Saves settings and moves to the next detailed conditions screen.
- **Exit:** Saves settings and closes the screen.
- **Cancel:** Discards settings and closes the screen.
4.6 Setting Channel Conditions for the Input Module (Detailed Setting Screen)

701262

Click Settings > Channel conditions in the TDC Correction and Calibration Factor screen > Detailed settings

Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Units</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel number</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Input coupling</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Probe</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Bandwidth limit</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Range</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Invert waveform</td>
<td>-</td>
<td>Prev. value</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

2 Input coupling: Select AC, DC, TC, or GND.
3 Bandwidth limit: If voltage is selected under input coupling, select 40 Hz, 400 Hz, 4 kHz, or Full, and if thermocouple (TC) is selected, select 2 Hz, 8 Hz, 30 Hz, or Full.
4 Range: Select a limit from the box. If the input coupling is AC, DC, or GND, select from 10 mV/div to 40 V/div (50 mV to 200 V), and if TC, select K, E, J, T, L, U, N, R, S, B, W, or iron doped gold/chromel (Au7Fe).
5 Invert waveform: Selects whether or not to invert the waveform on screen. Can only be set if AC, DC, or GND is selected under input coupling. Can be set if TC is selected.
6 TC Units: If the input coupling is TC, select °C, K or F.
7 RJC: Select RJC.
8 Burnout: Selects whether or not to perform a burnout check. Can only be set if TC is selected under input coupling. Cannot be set if AC, DC, or GND is selected.

Button Operations

Previous channel: Saves settings and moves to the previous detailed conditions screen.
Next channel: Saves settings and moves to the next detailed conditions screen.
Exit: Saves settings and closes the screen.
Cancel: Discards settings and closes the screen.
4.7 Setting Calculation Parameters (Parameter Settings Screen)

Click Settings > Parameters, or click FUNCTIONS.

**Functions**
- You can enter the engine type and other parameters necessary for combustion pressure analysis.
- You can select either Clearance volume or Compression ratio.
- Enter the number of data to be used when searching for the start and end of combustion through calculation. You can also specify the start and end points of combustion directly.
- Specify the range for searching for the maximum rate of heat release.
- Select the method of absolute pressure correction.
- Select whether or not to use this measured data for analysis when measuring intake manifold pressure, fuel consumption, revolutions per minute, and intake manifold temperature, (see numbers 16, 20, 23, and 26 in the table on the next page).
- When changing these settings, all previously calculated analysis results are discarded, and any currently displayed analysis results windows (crank angle graphs or numeric analysis data items) are forcibly closed.

After recalculation, display the analysis results window.
### Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Unit</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data Type</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Con-rod Length</td>
<td>mm</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bore</td>
<td>mm</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Piston offset</td>
<td>mm</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>-99999.999</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Stroke</td>
<td>mm</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Clearance volume</td>
<td>cm³</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Compression ratio</td>
<td>-</td>
<td>Prev. value</td>
<td>F</td>
<td>6.3</td>
<td>0</td>
<td>99.999</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Method of absolute pressure correction</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Start point of combustion</td>
<td>CA</td>
<td>Prev. value</td>
<td>F</td>
<td>6.2</td>
<td>-360</td>
<td>359.99</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Number of data items for judging start point of combustion</td>
<td>-</td>
<td>Prev. value</td>
<td>I</td>
<td>2</td>
<td>3</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>End point of combustion</td>
<td>CA</td>
<td>Prev. value</td>
<td>F</td>
<td>6.2</td>
<td>-360</td>
<td>359.99</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Number of data items for judging end point of combustion</td>
<td>-</td>
<td>Prev. value</td>
<td>I</td>
<td>2</td>
<td>3</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Window of searching maximum rate of heat release</td>
<td>CA</td>
<td>Prev. value</td>
<td>F</td>
<td>6.2</td>
<td>-360</td>
<td>359.99</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Ratio for judging angle of combustion mass rate</td>
<td>%</td>
<td>Prev. value</td>
<td>I</td>
<td>2</td>
<td>5</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Value for judging misfire</td>
<td>kPa</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Fuel consumption</td>
<td>cm³/s</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Measured fuel consumption</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Number of cylinders</td>
<td>-</td>
<td>Prev. value</td>
<td>I</td>
<td>1</td>
<td>1</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Gas constant</td>
<td>-</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Atmospheric temperature</td>
<td>°C</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>-273</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Measured intake manifold - temperature</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Atmospheric pressure</td>
<td>kPa</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Boost pressure</td>
<td>kPa</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Measured intake manifold - pressure</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Suction volumetric efficiency</td>
<td>%</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Revolutions per minute</td>
<td>rpm</td>
<td>Prev. value</td>
<td>I</td>
<td>5</td>
<td>0</td>
<td>99999</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Measured revolutions per minute</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Specific gravity</td>
<td>-</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Ratio of specific heat</td>
<td>-</td>
<td>Prev. value</td>
<td>F</td>
<td>9.3</td>
<td>0</td>
<td>99999.999</td>
<td></td>
</tr>
</tbody>
</table>
4.7 Setting Calculation Parameters (Parameter Settings Screen)

8 Start point of combustion: The specified value (without searching).
10 End point of combustion: The specified value (without searching).
12 Window of searching maximum rate of heat release:
   Set the range for finding the maximum angle of the rate of heat release used as the standard for searching for the start and end points of combustion.
13 Ratio for judging angle of combustion mass rate:
   Determines the crank angle at which the combustion mass rate matches the specified percentage.
14 Value for judging misfire:
   Cycles for which the IMEP is lower than this setting are judged as misfires, and the rate of misfire is determined by the ratio of the number of misfiring cycles relative to the total number of cycles.
16 Measured fuel consumption and Number of cylinders:
   Measures the fuel consumption, and when using the result for calculations, you can select this item or specify how many cylinders worth of fuel consumption it represents. In the TDC Correction and Calibration Factor Setting screen, it is assumed that fuel consumption (Gfuel) is assigned to a channel.
20 Measured intake manifold temperature:
   Select this item when measuring the temperature of the intake manifold and using the result for calculations. In the TDC Correction and Calibration Factor Setting screen, it is assumed that fuel consumption (Td) is assigned to a channel.
23 Measured intake manifold pressure:
   Select this item when measuring the pressure in the intake manifold and using the result for calculations. In the TDC Correction and Calibration Factor Setting screen, it is assumed that intake manifold pressure (Pitk) is assigned to a channel.
26 Measured revolutions per minute:
   Select this item when measuring rpm’s and using the result for calculations. In the TDC Correction and Calibration Factor Setting screen, it is assumed that rpm (Ne) is assigned to a channel.

Button Operations

Back: Saves settings and returns to the TDC Correction and Calibration Factor screen.
Next: Saves settings, moves to the Monitor screen, and starts updating of the Monitor screen.
Exit: Saves settings and closes the screen.
Cancel: Discards settings and closes the screen.
4.8 Displaying Measured Data

Click Display > Measured data

Functions
- Displays a crank angle graph in the Monitor screen of raw data (voltage data) that has been filtered according to the filter conditions.
- Raw data can be either before or after TDC correction, and you can select which data to display.
  
  **View > Measured data > Raw data:** Displays raw data before TDC correction
  **View > Measured data > Corrected data:** Displays raw data after TDC correction
- Shows the displayed channels, displayed cycles, and the current filter settings.
- When filter settings are changed, the display is updated.
- When nothing is displayed in the window, click **File > Setup Wizard**, or click . The measured data **Monitor** screen and **Setup** screen appear.

Button Operations (Icons)
- ![Start](Monitor > Start): Starts the monitor.
- ![Stop](Monitor > Stop): Stops the monitor.
4.9 Displaying Crank Angle Graphs

Displaying Crank Angle Graphs

Displays the value of the selected item

Click View > Crank angle graph > Cylinder pressure*

* You can select the analysis data items to display from the ones below. However some may not be selectable depending on the measurement condition settings. For details, see section 4.3, “Displayable Analysis Data Items.”

Cylinder pressure, rate of cylinder pressure rise, amount of heat release, rate of heat release, combustion mass rate, cylinder gas temperature, cylinder piston displacement, and other signals

Functions

- Displays a crank angle graph of one cycle’s worth of combustion pressure analysis results.
- The selected measurement items whose check boxes are selected (enabled) in the Numeric Analysis Data Items and Parameter Settings screens are displayed in the lower portion of the screen.
4.10 Displaying Numeric Analysis Data Items

Click View > Analysis data item

Functions
- Displays one cycle’s worth of combustion pressure analysis results in a list.
- The selected one numeric analysis data item is displayed as a trend. The item to trend-display can be selected when the monitor is stopped.
- The items selected from the measurement items whose check boxes are selected (enabled) in the Parameter Settings screen are displayed in the lower right portion of the screen.
4.11 Saving Measured Data (Saving to wdf Files)

While monitoring, click Save Waveform on the File menu or click [Save].

Functions

• Interrupts the monitor and displays the screen for Measuring data. When the number of cycles (when firing) specified in the measurement conditions is acquired, the file save dialog box is displayed. The raw (measured) data that has not undergone TDC correction or filtering is saved.

• When saving files, you can specify the number of cycles at which to start and stop loading.

• When saving is completed, the Calculation screen is automatically displayed.

• If you cancel the file save dialog box, the Measurement Wizard closes (and the Calculation screen is not displayed). To start the monitor again, click Monitor > Start monitor, or click [Save].

• When data acquisition starts, the Measuring data screen appears displaying the status and progress of data acquisition.

• When saving is completed, the Calculation screen is automatically displayed.
4.11 Saving Measured Data (Saving to wdf Files)

Setting/Display Data (the Save As Dialog Box)

Use this screen to specify the folder where files will be saved to and the file name. You can specify the number of cycles to save using the start cycle and end cycle.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No. of strokes</td>
<td>Displays the number of strokes in the selected file</td>
</tr>
<tr>
<td>2</td>
<td>No. of effective cycles</td>
<td>Displays the number of effective cycles in the selected file</td>
</tr>
<tr>
<td>3</td>
<td>No. of cycles to start/stop loading</td>
<td>Specifies the range of cycles with which to perform analysis of measured data files</td>
</tr>
<tr>
<td>4</td>
<td>Angular resolution</td>
<td>Displays the angular resolution of the selected file</td>
</tr>
</tbody>
</table>

Setting/Display Data (Measuring Data Screen)

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Progress bar</td>
<td>Displays the progress. The display is updated every 2 seconds during measurement, and the progress is reset to 0 when it reaches 100% (progresses 10% in 2 seconds).</td>
</tr>
<tr>
<td>2</td>
<td>Acquiring combustion data / trigger wait state</td>
<td>Displays after measurement starts when in trigger wait state. If this state continues, no external sampling signal is being input, or triggers are not activating. Click Abort.</td>
</tr>
<tr>
<td>3</td>
<td>Acquiring combustion data / performing trigger measurement</td>
<td>Displayed when a trigger activates and data is acquired</td>
</tr>
</tbody>
</table>

Button Operations

Abort: Aborts measurement and returns to the Monitor screen.

Save: Saves the file to the specified data file and moves to the Calculation screen.

Cancel: Cancels saving of combustion data and reopens the monitor.

Note

Can only save when monitoring (when the monitor start icon is active).
5.1 Loading Measured Data

Click File > Load measured data, or click  

**Functions**

- Loads the selected measured data file.
- To load data, set the following values.
  - Number of strokes
  - Range of cycles to be analyzed (load start cycle / load end cycle)
  - Crank angle resolution
- When loading is complete, the Measured Data Display screen (section 5.3) and Calculation screen (section 5.5) open automatically.
## 5.1 Loading Measured Data

### Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Numerical Data</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No. of Strokes</td>
<td>Value when saving</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>No. of effective cycles</td>
<td>Value when saving</td>
<td>1</td>
<td>5.0</td>
<td>1</td>
<td>25000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Start cycle</td>
<td></td>
<td>1</td>
<td>5.0</td>
<td>1</td>
<td>25000</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>End cycle</td>
<td>Number of effective</td>
<td>I</td>
<td>5.0</td>
<td>1</td>
<td>25000</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Angular Resolution</td>
<td>1.0</td>
<td>CA</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Measuring Instrument</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

2. No. of effective cycles: When selecting the file to be loaded, the angular resolution is assumed to be 1 CA, and the number of effective cycles is calculated using the equation below. If the angular resolution is changed to 0.5, 0.25, or 0.1, the number of effective cycles is updated accordingly.

\[
\text{Number of effective cycles} = \left( \frac{\text{no. of measured data}}{\text{no. of data per cycle}} \right) - 3
\]

The maximum number of effective cycles varies depending on the angular resolution as follows.

- For 1 CA: 25000 cycles
- For 0.5 CA: 12500 cycles
- For 0.25 CA: 6250 cycles
- For 0.1 CA: 2500 cycles

3. Start cycle, End cycle: Enter the range of cycles to be analyzed (up to 800 cycles). You cannot enter a value greater than the number of effective cycles for the data under analysis.

5. Angular Resolution: Select 1, 0.5, 0.25, or 0.1 according to the conditions during measurement.

6. Measuring Instrument: When loading files, the appropriate instrument is automatically selected.

### Button Operations

Open: Checks the start and stop cycles, and if the setting is correct, opens the Measured Data Display screen (see section 5.3) and the Calculation screen (see section 5.5). If the number of start/end cycles selected exceeds the maximum number of cycles of the data to be analyzed, a message is displayed.

Cancel: Clears all screen settings and closes the screen.
5.2 Saving/Loading Analysis Condition

Analysis Condition Loading screen

Click File > Open/save analysis conditions, or click , or .

Functions

Loading Analysis Condition

- Loads analysis conditions (TDC correction value, Number of cylinders, interval of absolute pressure correction, coefficients for conversion to physical values (calibration factors), filter setting conditions, calculation parameters, calculation execution items, analysis graph display conditions, screen layout), and places them into effect as the current conditions.

Note that when executing this function, all previously calculated analysis results are discarded, and any currently displayed analysis results windows (crank angle graphs, cycle graphs, or numeric analysis data items) are forcibly closed. After recalculation, display the analysis results window.

Saving Analysis Condition

- Saves analysis conditions (TDC correction value, Number of cylinders, interval of absolute pressure correction, coefficients for conversion to physical values (calibration factors), filter setting conditions, calculation parameters, calculation execution items, analysis graph display conditions, screen layout).
5.3 Displaying Measured Data

Click Display > Measured data > Raw data or Corrected data

Functions
- Displays a crank angle graph in the analysis screen of loaded measured data that has been filtered (raw data).
- Raw data can be either before or after TDC correction, and you can select which data to display.
  View > Measured data > Raw data: Displays raw data before TDC correction
  View > Measured data > Corrected data: Displays raw data after TDC correction
- The data name, cycle range, and angular resolution are displayed in the title bar of the window.
- Shows the displayed channels, displayed cycles, and the current filter settings.
- When filter settings are changed, the display is updated.
5.4 Setting the TDC Correction Value and Calibration Factor

Calculates the correction value using loaded measured data

Click Settings > TDC correction and calibration factor, or click

**Functions**

- You can change the calculated TDC correction value, number of engine cylinders, and cylinder-to-cylinder TDC correction value.
- When you click Calculate, the TDC correction value for the measured data being displayed is recalculated.
- When changing these settings, all previously calculated analysis results are discarded, and any currently displayed analysis results windows (crank angle graphs, cycle graphs, or numeric analysis data items) are forcibly closed. After recalculation, display the analysis results window.
- For details on setting the TDC correction value and calibration coefficient, see section 4.6.
5.5 Combustion Pressure Analysis

Click Calculation > Calculate, or click [III]

Functions

• You can select analysis data items and perform calculation. Cylinder pressure and rate of cylinder pressure rise are always analyzed.
• The check boxes of calculated items are selected. If a particular calculation is impossible, the item is skipped and the software advances to the next item.

Button Operations

Calculate: Calculates the selected data items (including related calculations). Click Calculate to display the Calculating screen. To stop the calculation in progress, click Stop.

Close Button: This button appears when calculation ends. Closes the window.

Cancel Button: This button disappears when calculation is started. Closes the window.

Select All Button: Selects all items for analysis.
5.6 Displaying Crank Angle Graphs

Displaying 2D Graphs

Click View > Crank angle graph > Cylinder pressure*

* You can select the analysis data item to display from the ones below. However you cannot select an item that has not been calculated. For information on performing calculations, see section 5.5.

Cylinder pressure, rate of cylinder pressure rise, amount of heat release, rate of heat release, combustion mass rate, cylinder gas temperature, cylinder piston displacement, logarithmic cylinder pressure, Polytropic index, and other signals

Functions

- Displays a crank angle graph of the combustion pressure analysis results.
- The selected values from the cycle graph data items and the measurement items set to Use in Calculations in the Parameter Settings screen are displayed in the lower right portion of the screen.

The following shows how the displayed contents varies depending on the settings for displayed channels and displayed cycles (see section 3.3, “Common Operations”).

<table>
<thead>
<tr>
<th>Display Channels</th>
<th>Cycles</th>
<th>Displayed Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified channel</td>
<td>Specified cycle</td>
<td>Value for specified cycles</td>
</tr>
<tr>
<td></td>
<td>AVE</td>
<td>Same values as in the numeric analysis data item screen</td>
</tr>
<tr>
<td></td>
<td>ALL</td>
<td>None</td>
</tr>
<tr>
<td>ALL</td>
<td>-</td>
<td>None</td>
</tr>
</tbody>
</table>
5.6 Displaying Crank Angle Graphs

Displaying 3D Graphs

If you select “3D” on the Graph Dimension Settings screen (see section 3.3, “Graph Operations”), the following 3D display appears.

Click View > Crank angle graph

Functions

- Crank angle display data is extracted each number of specified cycles from the specified range of cycles, and a 3D graph is displayed.
- The maximum number of cycles that can be displayed is 20.

Setting/Display Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Range of Cycles</td>
<td>Extracted cycles</td>
<td>3</td>
<td>1</td>
<td>800</td>
<td></td>
</tr>
</tbody>
</table>
5.7 Displaying Cycle Graphs

Click View > Cycle graph > Max. cylinder pressure*

You can select the analysis data item to display from the ones below. However you cannot select an item that has not been calculated. For information on performing calculations, see section 5.5.

Maximum cylinder pressure, angle of maximum cylinder pressure, averaged maximum cylinder pressure of all cylinders, averaged angle at maximum cylinder pressure of all cylinders, maximum rate of cylinder pressure rise, maximum angle of cylinder pressure rise, averaged maximum rate of cylinder pressure rise of all cylinders, average angle of maximum rate of cylinder pressure rise of all cylinders, NMEP, averaged NMEP of all cylinders, IMEP, averaged IMEP of all cylinders, PMEP, averaged PMEP of all cylinders, angle of maximum heat release, maximum amount of heat release, angle of maximum rate of heat release, maximum rate of heat release, angle at combustion mass rate N1%, angle at combustion mass rate N2%, angle at combustion mass rate N3%, other signals

Functions

- Displays a cycle graph of the combustion pressure analysis results in the Analysis screen.
- Displays in the bottom of the screen the average values (the same values as those in the Numeric Analysis Data Item screen) of the items selected from among the cycle graph items and the measurement items whose check boxes are selected (enabled) in the Parameter Settings screen.
5.8 Displaying Numeric Analysis Data Items

Click View > Analysis data item

Functions
- Displays the numeric analysis data items of the combustion pressure analysis results.
5.9 Saving Analysis Data

Click File > Save analysis data, or click .

Functions
- Test information can be entered and combustion pressure analysis results can be saved to a file in CSV format.

Setting/Display Data

For Numeric Data

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Default Setting</th>
<th>Data Type</th>
<th>Size</th>
<th>Min. Value</th>
<th>Max. Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data Name</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>8</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Testing Personnel</td>
<td>Prev. value</td>
<td>C</td>
<td>8</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Department</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>16</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Test Name</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>32</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>Engine model</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>16</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Serial No.</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>16</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>7</td>
<td>Place of Test</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>16</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>Test Bench</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>16</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>9</td>
<td>Comments</td>
<td>Prev. value</td>
<td>C(N)</td>
<td>32</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>10</td>
<td>Start cycle, End cycle</td>
<td>Prev. value</td>
<td>I</td>
<td>5.0</td>
<td>1</td>
<td>25000</td>
</tr>
</tbody>
</table>

10 Start cycle, End cycle: To save a specified range of cycles of crank angle graph data from the analysis results to a CSV file, choose this command, then enter the range of cycles to be saved. The suffix “-all” is added to the specified file name. For example, if you name the file Sample, the actual file name will change to Sample-all.csv when saved.

Button Operations
- Cancel: Clears all screen settings and closes the window.
- Save: Displays a window allowing you to specify the save location. Clicking OK in that window saves combustion pressure analysis results data to a text file in CSV format. Raw data cannot be saved.
5.10 Setting Filter Conditions and Calculation Parameters

Functions
You can change the following settings and perform combustion pressure analysis.
For details on settings, see the corresponding sections listed.
• Filter conditions: Section 4.4
• Calculation parameters: Section 4.7
6.1 Format of Analysis Data

Test Information, Manually Input Data Items

Test Information
Test date
Data name
Testing personnel
Department
Test name
Engine type
Serial No.
Place of test
Test bench type
Comments

Manually Input Data Items
Calculated TDC correction value (CA)
Number of cylinders
Channel-by-channel TDC correction value (CA)
Channel-by-channel calibration factor A (kPa/V)
Channel-by-channel calibration factor B (kPa/V)
Channel-by-channel used/unused (1: Used)
Starting angle of correction interval (CA)
Ending angle of correction interval (CA)
Channel name
Con-rod length (m)
Bore (m)
Piston offset (m)
Stroke length (m)
Clearance volume (m³)
Compression ratio
Boost pressure (kPa)
Number of cylinders
Angle for start point of combustion (point a) (CA)
Number of data items for judging start point of combustion
Angle for end point of combustion (point b) (CA)
Number of data items for judging end point of combustion
Start point of searching maximum rate of heat release (CA)
End point of searching maximum rate of heat release (CA)
Ratio for judging angle of combustion mass rate N1 (%)
Ratio for judging angle of combustion mass rate N2 (%)
Ratio for judging angle of combustion mass rate N3 (%)
Value for judging misfire (kPa)
Fuel consumption (m³/s)
Gas constant (×9.80665 J/kg.K)
Suction volumetric efficiency (%)
Specific gravity
Ratio of specific heat
Revolutions per minute (rpm)
Atmospheric temperature (°C)
Atmospheric pressure (kPa)
Method of absolute pressure correction
Calculation Results

Calculation Data Items: Numeric Analysis Data

- Average cylinder pressure across correction interval (kPa)
- Averaged maximum cylinder pressure (kPa)
- Standard deviation of maximum cylinder pressure (kPa)
- Rate of change in maximum cylinder pressure (%)
- Averaged maximum rate of cylinder pressure rise (kPa/deg)
- Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)
- Rate of change in maximum rate of cylinder pressure rise (%)
- Piston displacement (m³)
- Averaged NMEP (kPa)
- Standard deviation of NMEP (kPa)
- Rate of change in NMEP (%)
- Averaged IMEP (kPa)
- Standard deviation of IMEP (kPa)
- Rate of change in IMEP (%)
- Averaged PMEP (kPa)
- Standard deviation of PMEP (kPa)
- Rate of change in PMEP (%)
- Averaged maximum cylinder gas temperature (°C)
- Standard deviation of maximum cylinder gas temperature (°C)
- Rate of change in maximum cylinder gas temperature (%)
- Averaged maximum rate of heat release (J/deg)
- Standard deviation of maximum rate of heat release (J/deg)
- Rate of change in maximum rate of heat release (%)
- Averaged maximum amount of heat release (J)
- Standard deviation of maximum amount of heat release (J)
- Rate of change in maximum amount of heat release (%)
- Averaged angle at combustion mass rate N1 % (CA)
- Standard deviation of angle at combustion mass rate N1 % (CA)
- Rate of change in angle at combustion mass rate N1 % (%)
- Averaged angle at combustion mass rate N2 % (CA)
- Standard deviation of angle at combustion mass rate N2 % (CA)
- Rate of change in angle at combustion mass rate N2 % (%)
- Averaged angle at combustion mass rate N3 % (CA)
- Standard deviation of angle at combustion mass rate N3 % (CA)
- Rate of change in angle at combustion mass rate N3 % (%)
- Average start point of combustion (point a) (CA)
- Average end point of combustion (point b) (CA)
- Minimum value of IMEP (kPa)
- LNV of IMEP (%)  
- Rate of misfire (%)  
- Averaged maximum cylinder pressure of all cycles and cylinders (kPa)
- Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)
- Averaged NMEP of all cycles and cylinders (kPa)
- Averaged IMEP of all cycles and cylinders (kPa)
- Averaged PMEP of all cycles and cylinders (kPa)
- Minimum IMEP of all cycles and cylinders (kPa)
- LNV of IMEP of all cycles and cylinders (%)
## Calculation Data Items: Crank Angle Graph Data Items

- Crank angle
- Average cylinder pressure (kPa)
- Logarithmic average cylinder pressure (kPa)
- Piston displacement (m)
- Logarithmic piston displacement (m$^3$)
- Average rate of cylinder pressure rise (kPa/deg)
- Average cylinder gas temperature (°C)
- Average rate of heat release (J/deg)
- Average amount of heat release (J)
- Average combustion mass rate (%)
- Polytropic index

## Calculation Data Items: Cycle Graph Data Items

- Cycle
- Maximum cylinder pressure (kPa)
- Crank angle at maximum cylinder pressure (CA)
- Averaged maximum cylinder pressure of all cylinders (kPa)
- Averaged crank angle at maximum cylinder pressure of all cylinders (CA)
- Maximum rate of cylinder pressure rise (kPa/deg)
- Crank angle at maximum rate of cylinder pressure rise (CA)
- Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)
- Averaged angle at maximum rate of cylinder pressure rise of all cylinders (CA)
- Compression/expansion work (J)
- Pumping loss (J)
- NMEP (kPa)
- Averaged NMEP of all cylinders (kPa)
- IMEP (kPa)
- Averaged IMEP of all cylinders (kPa)
- PMEP (kPa)
- Averaged PMEP of all cylinders (kPa)
- Maximum cylinder gas temperature (°C)
- Crank angle at maximum cylinder gas temperature (CA)
- Maximum rate of heat release (J/deg)
- Crank angle at maximum rate of heat release (CA)
- Maximum amount of heat release (J)
- Crank angle at maximum amount of heat release (CA)
- Angle at combustion mass rate N1 % (CA)
- Angle at combustion mass rate N2 % (CA)
- Angle at combustion mass rate N3 % (CA)
- Start point of combustion (point a) (CA)
- End point of combustion (point b) (CA)

* When carrying out a per-cycle absolute pressure correction, the per-cycle absolute pressure correction value are left in the Calculation Item: Cycle Graph Data field.
6.1 Format of Analysis Data

Calculation Data Items: Crank Angle Graph Data (Other Signals) MBT2
- Crank angle
- Intake manifold pressure (kPa)
- Fuel consumption (cm³/s)
- Revolutions per minute (rpm)
- Intake manifold temperature (°C)
- Other signals (Crank angle graph data)

Calculation Data Items: Cycle Graph Data Items (Other Signals)
- Cycle
- Intake manifold pressure (kPa)
- Fuel consumption (cm³/s)
- Revolutions per minute (rpm)
- Intake manifold temperature (°C)
- Other signals (Cycle graph data)

Crank Angle Graph Data of Specified Range of Cycles
- Crank angle
- Cylinder pressure (kPa)
- Logarithmic cylinder pressure (kPa)
- Rate of cylinder pressure rise (kPa/deg)
- Cylinder gas temperature (°C)
- Rate of heat release (J/deg)
- Amount of heat release (J)
- Combustion mass rate (%)
- Intake manifold pressure (kPa)
- Fuel consumption (cm³/s)
- Revolutions per minute (rpm)
- Intake manifold temperature (°C)
- Other signals (Crank angle graph data)

* Intake manifold pressure, fuel consumption, rpm, and intake manifold temperature are saved only when they are measured.
7.1 Explanation of Equations

In the explanations below, 720 indicates the angle at cycle 1 for a 4-cycle engine. Substitute 360 for a 2-cycle engine.

1. \( P_{\theta \text{ in}} \)

Cylinder pressure (kPa) of the specified range of cycles extracted after rotational offset correction and TDC correction

\[
P_{\theta \text{ in}} = A \times U[720,N] + B
\]

- \( N \): Number of cycles
- \( U \): Voltage value (measured value) of the specified range of cycles extracted after rotational offset correction and TDC correction (V)
- \( A, B \): Sensor calibration factor (kPa/V) (manually input)

2. \( P_{\text{adj}[N]} \)

Average cylinder pressure (kPa) of the specified crank angle range used for the absolute pressure correction

For per-cycle average

\[
P_{\text{adj}[N]} = \text{ave}(P_{\theta \text{ in}}[\theta = \text{adj } \theta_1 \text{ to } \text{adj } \theta_2,N]) \quad \# \text{ ave: average value}
\]

For all-cycle average

\[
P_{\text{adj}[N]} = \text{ave}(P_{\theta \text{ in\_ave}}[\theta = \text{adj } \theta_1 \text{ to } \text{adj } \theta_2]) \quad \# \text{ ave: average value}
\]

- \( N \): Number of cycles
- \( P_{\theta \text{ in}} \): Cylinder pressure (kPa) (calculated value) of the specified range of cycles extracted after rotational offset correction and TDC correction
- \( P_{\theta \text{ in\_ave}} \): Average cylinder pressure (kPa) (calculated value)
- \( \text{adj } \theta_1 \): Starting angle (CA) of the range used for absolute pressure correction (manually input)
- \( \text{adj } \theta_2 \): Ending angle (CA) of the range used for absolute pressure correction (manually input)

3. \( P_{\text{itk\_ave}[N]} \)

Average intake manifold pressure at each cycle (kPa)

When intake manifold pressure is set to be measured and used in calculations:

\[
P_{\text{itk\_ave}[N]} = \text{ave}(P_{\theta \text{ itk}}[720,N]) \quad \# \text{ ave: average value}
\]

- \( N \): Number of cycles
- \( P_{\theta \text{ itk}} \): Intake manifold pressure (kPa) (measured value)
4. \( Pθ_{[720,N]} \)
Cylinder pressure after absolute pressure correction (kPa)

- When the atmospheric and boost pressures are manually input,
  \( Pθ_{[720,N]} = Pθ_{\text{in}[720,N]} - Padj[N] + Pa + Pt \)
- When depending on the measured intake manifold pressure,
  \( Pθ_{[720,N]} = Pθ_{\text{in}[720,N]} - Padj[N] + Pitk\_ave[N] \)

\( N \): Number of cycles
\( Pθ_{\text{in}} \): Cylinder pressure (kPa) after rotational offset correction and TDC correction (calculated value)
\( Padj \): Average cylinder pressure across correction interval (kPa) (calculated value)
\( Pa \): Atmospheric pressure (kPa) (manually input)
\( Pt \): Boost pressure (kPa) (manually input)
\( Pitk\_ave \): Average intake manifold pressure (kPa) (calculated value)

5. \( \log Pθ_{[720,N]} \)
Logarithmic cylinder pressure (kPa)

\( \log Pθ_{[720,N]} = \log_{10}(Pθ_{[720,N]}) \)

\( N \): Number of cycles
\( Pθ \): Cylinder pressure (kPa) after absolute pressure correction (calculated value)

6. \( Pθ\_ave[720] \)
Average cylinder pressure (kPa)

\( Pθ\_ave[720] = \left( \frac{1}{N} \right) \times \sum(Pθ_{[720,N]}) \)

\( N \): Number of cycles
\( Pθ \): Cylinder pressure (kPa) after absolute pressure correction (calculated value)

7. \( \log Pθ\_ave[720] \)
Logarithmic average cylinder pressure (kPa)

\( \log Pθ\_ave[720] = \log_{10}(Pθ\_ave[720]) \)

\( Pθ\_ave \): Average cylinder pressure (kPa) (calculated value)
8. **Xθ [720]**

Piston displacement (m)

\[ R = \frac{S}{2} \]

\[ \varphi = \arcsin \left( \frac{\gamma}{L + R} \right) \]

\[ Xθ = \sqrt{\left( \frac{R + L}{2} \right)^2 - \gamma^2} - R \cos(\left( \frac{\theta + \alpha}{\pi} \right) \times 180) + \varphi \]

\[ - \sqrt{\left( L^2 - \left( -R \sin(\left( \frac{\theta + \alpha}{\pi} \right) \times 180) + \varphi \right) + \gamma^2 \right)} \]

\( \# \text{ sqrt: square root} \)

S: Stroke length (m) (manually input)
L: Con-rod length (m) (manually input)
\( \gamma \): Piston offset (m) (manually input)
\( \theta \): Crank angle (CA) radian
4-cycle engine: \(-360\) to \(+360\) CA: at 1 CA resolution
2-cycle engine: \(-180\) to \(+180\) CA: at 1 CA resolution
\( \alpha \): The numbers to the right of the decimal of the TDC correction value (CA) (calculated or manually input). In other words, given an angular resolution of 1 CA, the value is \( (\theta - \alpha) = 0 - \alpha, 1 - \alpha, \ldots \)
\( \pi \): The circular constant

9. **Vθ [720]**

Piston displacement (m³)

When **Clearance volume** is selected on the Parameter Settings screen

\[ Vθ = \frac{\pi}{4} \times B^2 \times Xθ + Vc \]

When **Compression ratio** is selected on the Parameter Settings screen

\[ Vθ = \frac{\pi}{4} \times B^2 \times Xθ + Vst / (Cr-1) \]

\( \pi \): The circular constant
B: Bore (m) (manually input)
\( Xθ \): Piston displacement (m) (calculated value)
\( Vc \): Clearance volume (m³) (manually input)
\( Vst \): Piston displacement (m³) (calculated value)
\( Cr \): Compression ratio (manually input)
### 7.1 Explanation of Equations

**10. \( dV_\theta \ [720] \)**  
Rate of piston displacement increase (m\(^3\)/deg)  
\[ dV_\theta \ [720] = \frac{(V_{\theta_{n-2}} - 8 \times V_{\theta_{n-1}} + 8 \times V_{\theta_{n+1}} - V_{\theta_{n+2}})}{(12 \times \text{res})} \]  
When the angular resolution is 1 CA, the calculation is made as shown below.  
When \( n = 1 \) or 2, \((V_{\theta_{n-2}}, V_{\theta_{n-1}}) = (V_{\theta_{719}}, P_{\theta_{720}}) \) or \((V_{\theta_{720}}, V_{\theta_{001}}) \)  
When \( n = 719 \) or 720, \((V_{\theta_{719}}, V_{\theta_{n+2}}) = (V_{\theta_{720}}, V_{\theta_{001}}) \) or \((V_{\theta_{001}}, V_{\theta_{002}}) \)  
\( V_\theta \): Piston displacement (m\(^3\)) (calculated value)  
\( \text{res} \): Angular resolution (1, 0.5, 0.25, or 0.1 CA)

**11. \( \log V_\theta \ [720] \)**  
Logarithmic piston displacement (m\(^3\))  
\[ \log V_\theta \ [720] = \log_{10}(V_{\theta \ [720]}) \]  
\( V_\theta \): Piston displacement (m\(^3\)) (calculated value)

**12. \( dP_\theta \ [720,N] \)**  
Rate of cylinder pressure rise (kPa/deg)  
\[ dP_\theta \ [720,N] = \frac{(P_{\theta_{n-2}} - 8 \times P_{\theta_{n-1}} + 8 \times P_{\theta_{n+1}} - P_{\theta_{n+2}})}{(12 \times \text{res})} \]  
When the resolution is 1 CA, the calculation is made as shown below.  
When \( n = 1 \) or 2, \((P_{\theta_{n-2}}, P_{\theta_{n-1}}) = (P_{\theta_{001}}, P_{\theta_{001}}) \)  
When \( n = 719 \) or 720, \((P_{\theta_{719}}, P_{\theta_{720}}) = (P_{\theta_{720}}, P_{\theta_{001}}) \)  
\( \text{N} \): Number of cycles  
\( P_\theta \): Cylinder pressure (kPa) after absolute pressure correction (calculated value)  
\( \text{res} \): Angular resolution (1, 0.5, 0.25, or 0.1 CA)

**13. \( dP_\theta \text{ ave}[720] \)**  
Average rate of cylinder pressure rise (kPa/deg)  
\[ dP_\theta \text{ ave}[720] = \frac{1}{N} \times \sum(dP_\theta \ [720,N]) \]  
\( \text{N} \): Number of cycles  
\( dP_\theta \): Rate of cylinder pressure rise (kPa/deg) (calculated value)

**14. \( P_{\text{max}}[N] \)**  
Maximum cylinder pressure (kPa)  
\[ P_{\text{max}}[N] = \max(P_{\theta \ [720,N]}) \]  
\( \text{N} \): Number of cycles  
\( P_\theta \): Cylinder pressure (kPa) (calculated value)

**15. \( \theta_{\text{Pmax}} \ [N] \)**  
Crank angle at maximum cylinder pressure (CA)  
\[ \theta_{\text{Pmax}} \ [N] = \text{pos}(P_{\theta \ [720,N]}) \]  
\( \text{N} \): Number of cycles  
\( P_\theta \): Cylinder pressure (kPa) (calculated value)
16. $\theta_{P_{\text{max, ave}}}$

Averaged crank angle at maximum cylinder pressure (CA)

$\theta_{P_{\text{max, ave}}} = \frac{1}{N} \times \sum(\theta_{P_{\text{max}}}[N])$

$N$: Number of cycles

$\theta_{P_{\text{max}}}$: Crank angle at maximum cylinder pressure (CA) (calculated value)

17. $P_{\text{max, ave}}$

Averaged maximum cylinder pressure (kPa)

$P_{\text{max, ave}} = \frac{1}{N} \times \sum(P_{\text{max}}[N])$

$N$: Number of cycles

$P_{\text{max}}$: Maximum cylinder pressure (kPa) (calculated value)

18. $P_{\text{max, std}}$

Standard deviation of maximum cylinder pressure (kPa)

$P_{\text{max, std}} = \sqrt{\frac{1}{N-1} \times \sum(P_{\text{max}}[N] - P_{\text{max, ave}})^2}$ # $\sqrt{}$: square root

$N$: Number of cycles

$P_{\text{max}}$: Maximum cylinder pressure (kPa) (calculated value)

$P_{\text{max, ave}}$: Averaged maximum cylinder pressure (kPa) (calculated value)

19. $P_{\text{max, cov}}$

Rate of change (%) in maximum cylinder pressure

$P_{\text{max, cov}} = \frac{P_{\text{max, std}}}{P_{\text{max, ave}}} \times 100$

$P_{\text{max, std}}$: Standard deviation of the max. cylinder pressure (kPa) (calculated value)

$P_{\text{max, ave}}$: Averaged max. cylinder pressure (kPa) (calculated value)

20. $P_{\text{max, Cy}[N]}$

Averaged maximum cylinder pressure of all cylinders (kPa)

$P_{\text{max, Cy}[N]} = \frac{1}{Cy} \times \sum(P_{\text{max, Cy}}[Cy, N])$

$Cy$: Number of cylinders

$N$: Number of cycles

$P_{\text{max}}$: Maximum cylinder pressure (kPa) (calculated value)

21. $P_{\text{max, Cy, ave}}$

Averaged maximum cylinder pressure of all cycles and cylinders (kPa)

$P_{\text{max, Cy, ave}} = \frac{1}{N} \times \sum(P_{\text{max, Cy}}[N])$

$N$: Number of cycles

$P_{\text{max, Cy}}$: Averaged maximum cylinder pressure of all cylinders (kPa) (calculated value)
7.1 Explanation of Equations

22. $\theta_{P_{\text{max}_C\text{y}}} [N]$  
Averaged crank angle at maximum cylinder pressure of all cylinders (CA)  

$$\theta_{P_{\text{max}_C\text{y}}}[N] = \frac{1}{Cy} \times \sum_{i=1}^{N} \theta_{P_{\text{max}_C\text{y}}}[Cy_i, N]$$  
- $Cy$: Number of cylinders  
- $N$: Number of cycles  
- $\theta_{P_{\text{max}_C\text{y}}}$: Crank angle at maximum cylinder pressure (CA) (calculated value)

23. $\theta_{P_{\text{max}_C\text{y\_ave}}}$  
Averaged crank angle at maximum cylinder pressure of all cycles and cylinders (CA)  

$$\theta_{P_{\text{max}_C\text{y\_ave}}} = \frac{1}{N} \times \sum_{i=1}^{N} \theta_{P_{\text{max}_C\text{y}}}[N]$$  
- $N$: Number of cycles  
- $\theta_{P_{\text{max}_C\text{y\_ave}}}$: Averaged crank angle at maximum cylinder pressure of all cylinders (CA) (calculated value)

24. $dP_{\text{max}}[N]$  
Maximum rate of cylinder pressure rise (kPa/deg)  

$$dP_{\text{max}}[N] = \max_{N \in \mathbb{Z}}(dP_{\theta}[720,N])$$  
- $N$: Number of cycles  
- $dP_{\theta}$: Rate of cylinder pressure rise (kPa/deg) (calculated value)

25. $\theta_{dP_{\text{max}}}$  
Crank angle at maximum rate of cylinder pressure rise (CA)  

$$\theta_{dP_{\text{max}}}[N] = \text{pos}(dP_{\theta}[720,N])$$  
- $N$: Number of cycles  
- $dP_{\theta}$: Rate of cylinder pressure rise (kPa/deg) (calculated value)

26. $\theta_{dP_{\text{max\_ave}}}$  
Averaged crank angle at maximum rate of cylinder pressure rise (CA)  

$$\theta_{dP_{\text{max\_ave}}} = \frac{1}{N} \times \sum_{i=1}^{N} \theta_{dP_{\text{max}}}[N]$$  
- $N$: Number of cycles  
- $\theta_{dP_{\text{max\_ave}}}$: Crank angle at maximum rate of cylinder pressure rise (CA) (calculated value)

27. $dP_{\text{max\_ave}}$  
Averaged maximum rate of cylinder pressure rise (kPa/deg)  

$$dP_{\text{max\_ave}} = \frac{1}{N} \times \sum_{i=1}^{N} dP_{\text{max}}[N]$$  
- $N$: Number of cycles  
- $dP_{\text{max\_ave}}$: Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)
Equations

28. **dPmax_std**

Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)

\[
\text{dPmax}_\text{std} = \sqrt{\left(\frac{1}{(N-1)} \times \sum (\text{dPmax}_\text{N} - \text{dPmax}_\text{ave})^2 \right)} \\
\text{sqrt} \text{: square root}
\]

N: Number of cycles

dPmax: Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)
dPmax_ave: Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated value)

29. **dPmax_cov**

Rate of change (%) in maximum cylinder pressure rise

\[
\text{dPmax}_\text{cov} = \left(\frac{\text{dPmax}_\text{std}}{\text{dPmax}_\text{ave}}\right) \times 100
\]

\[
\text{dPmax}_\text{std}: \text{Standard deviation of maximum rate of cylinder pressure rise (kPa/deg)} \\
\text{dPmax}_\text{ave}: \text{Averaged maximum rate of cylinder pressure rise (kPa/deg) (calculated value)}
\]

30. **dPmax_Cy[N]**

Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg)

\[
\text{dPmax}_\text{Cy[N]} = \left(\frac{1}{\text{Cy}}\right) \times \sum (\text{dPmax}_{\text{Cy, N}})
\]

Cy: Number of cylinders

\[
\text{N}: \text{Number of cycles} \\
\text{dPmax}: \text{Maximum rate of cylinder pressure rise (kPa/deg) (calculated value)}
\]

31. **dPmax_Cy_ave**

Averaged maximum rate of cylinder pressure rise of all cycles and cylinders (kPa/deg)

\[
\text{dPmax}_\text{Cy_ave} = \left(\frac{1}{\text{N}}\right) \times \sum (\text{dPmax}_\text{Cy[N]})
\]

N: Number of cycles

\[
\text{N}: \text{Number of cycles} \\
\text{dPmax}_\text{Cy}: \text{Averaged maximum rate of cylinder pressure rise of all cylinders (kPa/deg) (calculated value)}
\]

32. **θdPmax_Cy [N]**

Averaged crank angle at maximum rate of cylinder pressure rise of all cylinders (CA)

\[
\text{θdPmax}_\text{Cy[N]} = \left(\frac{1}{\text{Cy}}\right) \times \sum (\text{θdPmax}_{\text{Cy, N}})
\]

\[
\text{Cy}: \text{Number of cylinders} \\
\text{N}: \text{Number of cycles} \\
\text{θdPmax}: \text{Crank angle at maximum rate of cylinder pressure rise (CA) (calculated value)}
\]

33. **θdPmax_Cy_ave**

Averaged crank angle at maximum rate of cylinder pressure rise of all cycles and cylinders (CA)

\[
\text{θdPmax}_\text{Cy_ave} = \left(\frac{1}{\text{N}}\right) \times \sum (\text{θdPmax}_\text{Cy[N]})
\]

N: Number of cycles

\[
\text{N}: \text{Number of cycles} \\
\text{θdPmax}_\text{Cy}: \text{Averaged crank angle at maximum rate of cylinder pressure rise of all cylinders (CA) (calculated value)}
\]
### 34. Wpower [N]
Compression/expansion work (J)

\[ \Delta V = \text{abs}(V_{\theta_i} - V_{\theta_{i+1}}) \quad \# \text{abs: absolute value} \]

\[ A[N] = \sum (0.5 \times (P_{\theta_i} + P_{\theta_{i+1}}) \times 1000.0 \times \Delta V) \quad \theta = -180 \text{ to } -1 \]

\[ B[N] = \sum (0.5 \times (P_{\theta_i} + P_{\theta_{i+1}}) \times 1000.0 \times \Delta V) \quad \theta = 0 \text{ to } 179 \]


For a 2-cycle engine, when \( \theta = 179 \), \( P_{\theta_{i+1}} \) is \( P_{\theta_i} \), and \( V_{\theta_{i+1}} \) is \( V_{\theta_{-180}} \).

- **N**: Number of cycles
- **V\theta**: Piston displacement (m³) (calculated value)
- **P\theta**: Cylinder pressure (kPa) after absolute pressure correction (calculated value)

### 35. Wpump[N]
Pumping loss (J)

\[ \Delta V = \text{abs}(V_{\theta_i} - V_{\theta_{i+1}}) \quad \# \text{abs: absolute value} \]

\[ C[N] = \sum (0.5 \times (P_{\theta_i} + P_{\theta_{i+1}}) \times 1000.0 \times \Delta V) \quad \theta = 180 \text{ to } 359 \]

\[ D[N] = \sum (0.5 \times (P_{\theta_i} + P_{\theta_{i+1}}) \times 1000.0 \times \Delta V) \quad \theta = -360 \text{ to } -181 \]

\[ \text{Wpump}[N] = C[N] - D[N] \]

When \( \theta = 359 \), \( P_{\theta_{i+1}} \) is \( P_{\theta_i} \), and \( V_{\theta_{i+1}} \) is \( V_{\theta_{-360}} \).

\[ \text{Wpump}[N] \] is zero for 2-cycle engines.

- **N**: Number of cycles
- **V\theta**: Piston displacement (m³) (calculated value)
- **P\theta**: Cylinder pressure (kPa) after absolute pressure correction (calculated value)

### 36. Vst
Piston displacement (m³)

\[ V_{\text{st}} = (\pi / 4) \times B^2 \times S \]

- **\pi**: The circular constant
- **B**: Bore (m) (manually input)
- **S**: Stroke length (m) (manually input)

### 37. NMEP[N]
NMEP (kPa)

\[ \text{NMEP}[N] = (\text{Wpower}[N] / 1000.0 - \text{Wpump}[N] / 1000.0) / V_{\text{st}} \]

- **N**: Number of cycles
- **Wpower**: Compression/expansion work (J) (calculated value)
- **Wpump**: Pumping loss (J) (calculated value)
- **Vst**: Piston displacement (m³) (calculated value)

### 38. NMEP_ave
Averaged NMEP (kPa)

\[ \text{NMEP}_\text{ave} = (1 / N) \times \sum(\text{NMEP}[N]) \]

- **N**: Number of cycles
- **NMEP**: NMEP (kPa) (calculated value)
7.1 Explanation of Equations

39. **NMEP_std**

   Standard deviation of NMEP (kPa)
   
   \[
   \text{NMEP\_std} = \sqrt{\left(\frac{1}{(N-1)} \times \sum (\text{NMEP}[N] - \text{NMEP\_ave})^2\right)} \quad \#\text{sqrt: square root}
   \]

   - **N**: Number of cycles
   - **NMEP**: NMEP (kPa) (calculated value)
   - **NMEP\_ave**: Averaged NMEP (kPa) (calculated value)

40. **NMEP\_cov**

   Rate of change in NMEP (%)
   
   \[
   \text{NMEP\_cov} = \left(\frac{\text{NMEP\_std}}{\text{NMEP\_ave}}\right) \times 100
   \]

   - **NMEP\_std**: Standard deviation of NMEP (kPa) (calculated value)
   - **NMEP\_ave**: Averaged NMEP (kPa) (calculated value)

41. **NMEP\_Cy[N]**

   Averaged NMEP of all cylinders (kPa)
   
   \[
   \text{NMEP\_Cy[N]} = \left(\frac{1}{C} \times \sum \text{NMEP\_Cy[Cy, N]}\right)
   \]

   - **C**: Number of cylinders
   - **N**: Number of cycles
   - **NMEP\_Cy**: Averaged NMEP of all cylinders (kPa) (calculated value)

42. **NMEP\_Cy\_ave**

   Averaged NMEP of all cycles and cylinders (kPa)
   
   \[
   \text{NMEP\_Cy\_ave} = \left(\frac{1}{N} \times \sum \text{NMEP\_Cy}[N]\right)
   \]

   - **N**: Number of cycles
   - **NMEP\_Cy**: Averaged NMEP of all cylinders (kPa) (calculated value)

43. **IMEP[N]**

   IMEP (kPa)
   
   \[
   \text{IMEP}[N] = \frac{\text{Wpower}[N]}{1000.0} / \text{Vst}
   \]

   - **N**: Number of cycles
   - **Wpower**: Compression/expansion work (J) (calculated value)
   - **Vst**: Piston displacement (m3) (calculated value)

44. **IMEP\_ave**

   Averaged IMEP (kPa)
   
   \[
   \text{IMEP\_ave} = \left(\frac{1}{N} \times \sum \text{IMEP}[N]\right)
   \]

   - **N**: Number of cycles
   - **IMEP**: IMEP (kPa) (calculated value)
7.1 Explanation of Equations

45. **IMEP_std**
   Standard deviation of IMEP (kPa)
   \[ \text{IMEP}_\text{std} = \sqrt{\frac{1}{N-1} \times \sum \text{IMEP}[N] - \text{IMEP}_\text{ave}^2} \]
   # sqrt: square root
   
   \( N \): Number of cycles
   \( \text{IMEP} \): IMEP (kPa) (calculated value)
   \( \text{IMEP}_\text{ave} \): Averaged IMEP (kPa) (calculated value)

46. **IMEP_cov**
   Rate of change in IMEP (%)
   \[ \text{IMEP}_\text{cov} = \left( \frac{\text{IMEP}_\text{std}}{\text{IMEP}_\text{ave}} \right) \times 100 \]
   
   \( \text{IMEP}_\text{std} \): Standard deviation of IMEP (kPa) (calculated value)
   \( \text{IMEP}_\text{ave} \): Averaged IMEP (kPa) (calculated value)

47. **IMEP_min**
   Minimum value of IMEP (kPa)
   \[ \text{IMEP}_\text{min} = \min(\text{IMEP}[N]) \]
   # min: minimum value
   
   \( N \): Number of cycles
   \( \text{IMEP} \): IMEP (kPa) (calculated value)

48. **IMEP_LNV**
   LNV of IMEP (%)
   \[ \text{IMEP}_\text{LNV} = \left( \frac{\text{IMEP}_\text{min}}{\text{IMEP}_\text{ave}} \right) \times 100 \]
   
   \( \text{IMEP}_\text{min} \): Minimum value of IMEP (kPa)
   \( \text{IMEP}_\text{ave} \): Averaged IMEP (kPa) (calculated value)

49. **R_misfire**
   Rate of misfire (%)
   \[ \text{R}_\text{misfire} = \left( \frac{\text{count}(\text{IMEP}[N] < L)}{N} \right) \times 100 \]
   # count: calculates the number of data that are applicable to the specified conditions
   
   \( N \): Number of cycles
   \( L \): Value for judging misfire (kPa) (manually input)
   \( \text{IMEP} \): IMEP (kPa) (calculated value)

50. **IMEP_Cy[N]**
   Averaged IMEP of all cylinders (kPa)
   \[ \text{IMEP}_\text{Cy}[N] = \frac{1}{\text{Cy}} \times \sum \text{IMEP}[\text{Cy}, N] \]
   
   \( \text{Cy} \): Number of cylinders
   \( N \): Number of cycles
   \( \text{IMEP} \): IMEP (kPa) (calculated value)

51. **IMEP_Cy_ave**
   Averaged IMEP of all cycles and cylinders (kPa)
   \[ \text{IMEP}_\text{Cy}_\text{ave} = \frac{1}{N} \times \sum \text{IMEP}_\text{Cy}[N] \]
   
   \( N \): Number of cycles
   \( \text{IMEP}_\text{Cy} \): Averaged IMEP of all cylinders (kPa) (calculated value)
7.1 Explanation of Equations

52. PMEP[N]

PMEP (kPa)

PMEP[N] = ((–1 × Wpump [N]) / 1000.0) / Vst

N: Number of cycles
Wpump: Pumping loss (J) (calculated value)
Vst: Piston displacement (m3) (calculated value)

53. PMEP_ave

Averaged PMEP (kPa)

PMEP_ave = (1 / N) × Σ(PMEP [N])

N: Number of cycles
PMEP: PMEP (kPa) (calculated value)

54. PMEP_std

Standard deviation of PMEP (kPa)

PMEP_std = sqrt((1 / (N–1)) × Σ(PMEP[N] – PMEP_ave)^2)  # sqrt: square root

N: Number of cycles
PMEP: PMEP (kPa) (calculated value)
PMEP_ave: Averaged PMEP (kPa) (calculated value)

55. PMEP_cov

Rate of change in PMEP (%)

PMEP_cov = (PMEP_std / PMEP_ave) × 100

PMEP_std: Standard deviation of PMEP (kPa) (calculated value)
PMEP_ave: Averaged PMEP (kPa) (calculated value)

56. PMEP_Cy[N]

Averaged PMEP of all cylinders (kPa)

PMEP[N] = (1 / Cy) × Σ(IMEP [Cy, N])

Cy: Number of cylinders
N: Number of cycles
NMEP: PMEP (kPa) (calculated value)

57. PMEP_Cy_ave

Averaged PMEP of all cycles and cylinders (kPa)

PMEP_Cy_ave = (1 / N) × Σ(PMEP_Cy [N])

N: Number of cycles
PMEP_Cy: Averaged PMEP of all cylinders (kPa) (calculated value)
7.1 Explanation of Equations

58. Gf

Mass of intake fuel (kg)

\[ G_f = (G_{fuel} \times (1 / 1000) \times C_v) \times \left( (60 \times E_{n,cyl}) / N_e \right) \]

When fuel consumption and rpm are set to be measured and used in calculations:

\[ G_f[N] = (G_{fuel, ave[N]} \times (1 / 1000) \times C_v) \times \left( (60 \times E_{n,cyl}) / N_e[ave[N]] \right) \]

- \( N \): Number of cycles
- \( G_{fuel} \): Fuel consumption (cm³/s) (manually input)
- \( C_v \): Specific gravity (manually input)
- \( E_{n,cyl} \): Engine cycle
  - 4-cycle engine: \( E_{n,cyl} = 2 \)
  - 2-cycle engine: \( E_{n,cyl} = 1 \)
- \( N_e \): Revolutions per minute (rpm) (manually input)

When rpm is set to be measured and used in calculations:

\[ N_e[N] = \text{ave}(N_e[720,N]) \] # ave: average value

59. Ga

Mass of intake air (kg)

\[ G_a = \left( V_{eff} \times \left( P_{atm} \times \left( V_{st} \times (29.27 \times (T_{d} + 273.16)) \right) \right) \right) \]

When intake manifold pressure and intake manifold temperature are set to be measured and used in calculations:

\[ G_a[N] = \left( V_{eff} \times \left( P_{itk, ave[N]} \times \left( V_{st} \times (29.27 \times (T_{d, ave[N]} + 273.16)) \right) \right) \right) \]

- \( N \): Number of cycles
- \( V_{eff} \): Suction volumetric efficiency (%) (manually input)
- \( P_{atm} \): Atmospheric pressure (kPa) (manually input)
- \( V_{st} \): Piston displacement (m³) (calculated value)
- \( T_{d} \): Atmospheric temperature (°C) (manually input)

When intake manifold temperature is set to be measured and used in calculations:

\[ T_{d, ave[N]} = \text{ave}(T_d[720,N]) \] # ave: average value
7.1 Explanation of Equations

60. Tθ [720,N]
Cylinder gas temperature (°C)

\[ T\theta [720,N] = \left( \frac{P\theta [720,N] \times 10000}{98.0665} \times V\theta [720] \right) / \left( \frac{Gf + Ga}{R} \right) - 273.16 \]

When intake manifold pressure, intake manifold temperature, fuel consumption, and rpm are set to be measured and used in calculations:

\[ T\theta [720,N] = \left( \frac{P\theta [720,N] \times 10000}{98.0665} \times V\theta [720] \right) / \left( \frac{(Gf[N] + Ga[N])}{R} \right) - 273.16 \]

N: Number of cycles
Pθ: Cylinder pressure (kPa) after absolute pressure correction (calculated value)
Vθ: Piston displacement (m³) (calculated value)
Gf: Mass of intake fuel (kg)
Gf[N]: The calculated value for mass of intake fuel (kg) when fuel consumption and rpm are set to be measured and used in calculations
Ga: Mass of intake air (kg)
Ga[N]: The calculated value for mass of intake air (kg) when intake manifold pressure and intake manifold temperature are set to be measured and used in calculations
R: Gas constant (× 9.80665 J/kg K) (manually input)

61. Tθ ave[720]
Average cylinder gas temperature (°C)

\[ T\theta \text{ ave}[720] = \left( \frac{1}{N} \times \Sigma(T\theta [720,N]) \right) \]

N: Number of cycles
Tθ: Cylinder gas temperature (°C) (calculated value)

62. Tmax[N]
Maximum cylinder gas temperature (°C)

\[ \text{Tmax}[N] = \max(T\theta [720,N]) \quad \# \text{ max: maximum value} \]

N: Number of cycles
Tθ: Cylinder gas temperature (°C) (calculated value)

63. θTmax[N]
Crank angle (CA) at maximum cylinder gas temperature

\[ \theta \text{Tmax}[N] = \text{pos}(T\theta [720,N]) \quad \# \text{ pos: crank angle at the maximum cylinder gas temperature} \]

N: Number of cycles
Tθ: Cylinder gas temperature (°C) (calculated value)

64. Tmax_ave
Averaged maximum cylinder gas temperature (°C)

\[ \text{Tmax_ave} = \left( \frac{1}{N} \times \Sigma(\text{Tmax}[N]) \right) \]

N: Number of cycles
Tmax: Maximum cylinder gas temperature (°C) (calculated value)
### 7.1 Explanation of Equations

#### 65. T\text{max\_std}

Standard deviation of maximum cylinder gas temperature (°C)

\[
T_{\text{max\_std}} = \sqrt{\left(\frac{1}{N-1}\right) \times \sum (T_{\text{max}} - T_{\text{max\_ave}})^2}
\]

- \(N\): Number of cycles
- \(T_{\text{max}}\): Maximum cylinder gas temperature (°C) (calculated value)
- \(T_{\text{max\_ave}}\): Averaged maximum cylinder gas temperature (°C) (calculated value)

#### 66. T\text{max\_cov}

Rate of change in maximum cylinder gas temperature (%)

\[
T_{\text{max\_cov}} = \left(\frac{T_{\text{max\_std}}}{T_{\text{max\_ave}}}\right) \times 100
\]

- \(T_{\text{max\_std}}\): Standard deviation of maximum cylinder gas temperature (°C) (calculated value)
- \(T_{\text{max\_ave}}\): Averaged maximum cylinder gas temperature (°C) (calculated value)

#### 67. dQθ [720,N]

Rate of heat release (J/deg)

\[
dQ\theta\ [720,N] = \left(\frac{\kappa}{\kappa-1}\right) \times P\theta\ [720,N] \times 1000.0 \times dV\theta\ [720] + \left(1 - \frac{1}{\kappa}\right) \times dP\theta\ [720,N] \times 1000.0 \times V\theta\ [720]
\]

- \(N\): Number of cycles
- \(\kappa\): Ratio of specific heat (manually input)
- \(P\theta\): Cylinder pressure (kPa) after absolute pressure correction (calculated value)
- \(V\theta\): Piston displacement (m³) (calculated value)
- \(dV\theta\): Rate of cylinder volume increase (m³/deg) (calculated value)
- \(dP\theta\): Rate of cylinder pressure rise (kPa/deg) (calculated value)

#### 68. dQ\theta\ ave[720]

Average rate of heat release (J/deg)

\[
dQ\theta\ \text{ave}[720] = \frac{1}{N} \times \sum (dQ\theta\ [720,N])
\]

- \(N\): Number of cycles
- \(dQ\theta\): Rate of heat release (J/deg) (calculated value)

#### 69. dQmax[N]

Maximum rate of heat release (J/deg)

\[
dQ\text{max}[N] = \max(dQ\theta\ [720,N])
\]

- \(N\): Number of cycles
- \(dQ\theta\): Rate of heat release (J/deg) (calculated value)

#### 70. θdQmax[N]

Crank angle at maximum rate of heat release (CA)

\[
\theta dQ\text{max}[N] = \text{pos}(dQ\theta\ [720,N])
\]

- \(N\): Number of cycles
- \(dQ\theta\): Rate of heat release (J/deg) (calculated value)
71. $\theta dQ_{\text{max} \_\text{ave}}$
Averaged crank angle at maximum rate of heat release (CA)

$$\theta dQ_{\text{max} \_\text{ave}} = \frac{1}{N} \times \Sigma(\theta dQ_{\text{max}}[N])$$

$N$: Number of cycles

$\theta dQ_{\text{max}}$: Crank angle at maximum rate of heat release (CA) (calculated value)

72. $dQ_{\text{max} \_\text{ave}}$
Averaged maximum rate of heat release (J/deg)

$$dQ_{\text{max} \_\text{ave}} = \frac{1}{N} \times \Sigma(dQ_{\text{max}}[N])$$

$N$: Number of cycles

dQmax: Maximum rate of heat release (J/deg) (calculated value)

73. $dQ_{\text{max} \_\text{std}}$
Standard deviation of maximum rate of heat release (J/deg)

$$dQ_{\text{max} \_\text{std}} = \sqrt{\frac{1}{N-1} \times \Sigma(dQ_{\text{max}}[N] - dQ_{\text{max} \_\text{ave}})^2}$$

# sqrt: square root

$N$: Number of cycles

dQmax: Maximum rate of heat release (J/deg) (calculated value)

dQmax_ave: Averaged maximum rate of heat release (J/deg) (calculated value)

74. $dQ_{\text{max} \_\text{cov}}$
Rate of change (%) in maximum rate of heat release

$$dQ_{\text{max} \_\text{cov}} = \left(\frac{dQ_{\text{max} \_\text{std}}}{dQ_{\text{max} \_\text{ave}}}\right) \times 100$$

dQmax_std: Standard deviation of the maximum rate of heat release (J/deg) (calculated value)

dQmax_ave: Averaged maximum rate of heat release (J/deg) (calculated value)

75. $Q(\theta)[720,N]$
Amount of heat release (J)

$$Q(\theta)[720,N] = \Sigma(dQ\theta) \times \text{res}$$

Cumulative sum from point a to $\theta$. dQ$\theta$ is zero from 0 to point a.

$N$: Number of cycles

dQ$\theta$: Rate of heat release (J/deg) (calculated value)

res: Angular resolution (1, 0.5, 0.25, or 0.1 CA)

a: Start point of combustion. Crank angle (CA) at which the value of dQ$\theta$ is changed to a positive value immediately before Qmax (calculated value) (value automatically searched for, starting from dQmax in the direction of decreasing angles)

When manually input, the setting value is assumed to be point “a.”

76. $Q(\theta)\_\text{ave}[720]$
Average amount of heat release (J)

$$Q(\theta)\_\text{ave}[720] = \frac{1}{N} \times \Sigma(Q(\theta)[720,N])$$

$N$: Number of cycles

Q$\theta$: Amount of heat release (J) (calculated value)
7.1 Explanation of Equations

77. Qmax [N]
   Maximum amount of heat release (J)
   \[ Q_{\text{max}}[N] = \max(Q_0 \,[720,N]) \]  
   \# \textit{max}: maximum value
   \begin{itemize}
     \item N: Number of cycles
     \item Q₀: Amount of heat release (J) (calculated value)
   \end{itemize}

78. θQmax [N]
   Crank angle (CA) at maximum amount of heat release
   \[ \theta_{Q_{\text{max}}}[N] = \text{pos}(Q_0 \,[720,N]) \]  
   \# \textit{pos}: crank angle at the maximum amount of heat release
   \begin{itemize}
     \item N: Number of cycles
     \item Q₀: Amount of heat release (J) (calculated value)
   \end{itemize}

79. θQmax_ave
   Averaged crank angle at maximum amount of heat release (CA)
   \[ \theta_{Q_{\text{max}}_\text{ave}} = \frac{1}{N} \times \sum(\theta_{Q_{\text{max}}}[N]) \]
   \begin{itemize}
     \item N: Number of cycles
     \item \theta_{Q_{\text{max}}}: Crank angle at maximum amount of heat release (CA) (calculated value)
   \end{itemize}

80. Qmax_ave
   Averaged maximum amount of heat release (J)
   \[ Q_{\text{max}_\text{ave}} = \frac{1}{N} \times \sum(Q_{\text{max}}[N]) \]
   \begin{itemize}
     \item N: Number of cycles
     \item Q_{\text{max}}: Maximum amount of heat release (J) (calculated value)
   \end{itemize}

81. Qmax_std
   Standard deviation of maximum amount of heat release (J)
   \[ Q_{\text{max}_\text{std}} = \sqrt{\frac{1}{N-1} \times \sum(Q_{\text{max}}[N] - Q_{\text{max}_\text{ave}})^2} \]  
   \# \textit{sqrt}: square root
   \begin{itemize}
     \item N: Number of cycles
     \item Q_{\text{max}}: Maximum amount of heat release (J) (calculated value)
     \item Q_{\text{max}_\text{ave}}: Averaged maximum amount of heat release (J) (calculated value)
   \end{itemize}

82. Qmax_cov
   Rate of change (%) in maximum amount of heat release
   \[ Q_{\text{max}_\text{cov}} = \left( \frac{Q_{\text{max}_\text{std}}}{Q_{\text{max}_\text{ave}}} \right) \times 100 \]
   \begin{itemize}
     \item Q_{\text{max}_\text{std}}: Standard deviation of maximum amount of heat release (J) (calculated value)
     \item Q_{\text{max}_\text{ave}}: Averaged maximum amount of heat release (J) (calculated value)
   \end{itemize}
83. Qab

Amount of heat release during the combustion period (J)

\[ Q_{ab}[N] = \sum (dQ\theta[720,N]) \times \text{res} \]

The sum from point a to point b at each cycle

- **N**: Number of cycles
- **dQ\theta**: Rate of heat release (J/deg) (calculated value)
- **res**: Angular resolution (1, 0.5, 0.25, or 0.1 CA)
- **a**: Start point of combustion. Crank angle (CA) at which the value of dQ\theta is changed to a positive value immediately before \(dQ_{max}\) (calculated value)
  - When manually input, the setting value is assumed to be point “a.”
- **b**: End point of combustion. Crank angle (CA) at which the value of dQ\theta is changed to a negative value immediately after \(dQ_{max}\) (calculated value)
  - When manually input, the setting value is assumed to be point “b.”

84. Qab_ave

Average amount of heat release during the combustion period (J)

\[ Q_{ab\_ave} = \frac{1}{N} \times Q_{ab}[N] \]

- **N**: Number of cycles
- **Qab**: Amount of heat release during the combustion period (J) (calculated value)

85. RH\theta [720,N]

Combustion mass rate (%)

\[ RH\theta[720, N] = \frac{Q\theta[720,N]}{Q_{ab}[N]} \]

- **N**: Number of cycles
- **Q\theta**: Amount of heat release (J) (calculated value)
- **Qab**: The calculated sum (J) from point a to point b at each cycle

86. RH\theta ave[720]

Average combustion mass rate (%)

\[ RH\theta_{ave}[720] = \frac{1}{N} \times \sum (RH\theta[720,N]) \]

- **N**: Number of cycles
- **RH\theta**: Combustion mass rate (%) (calculated value)

87. \theta RH[N]

Crank angle at combustion mass rate N1 % (CA)

\( \theta RH[N] = \text{floor}(\text{round}(RH\theta[720,N]), \text{ratio}) \)

- **floor**: the angle whereby \(RH\theta\) is greater than ratio (depending on the angular resolution)
- **round**: round to 1 digit after the decimal place

- **N**: Number of cycles
- **RH\theta**: Combustion mass rate (%) (calculated value)
- **ratio**: Ratio for judging angle of combustion mass rate N1 % (%) (manually input)
### 7.1 Explanation of Equations

**88. θRH_ave**

Averaged angle at combustion mass rate N1 % (CA)

\[
θRH_\text{ave} = \frac{1}{N} \times \sum(θRH[N])
\]

- \(N\): Number of cycles
- \(θRH\): Angle at combustion mass rate N1 % (CA) (calculated value)

**89. θRH_std**

Standard deviation of angle at combustion mass rate N1 % (CA)

\[
θRH_\text{std} = \sqrt{\frac{1}{N - 1} \times \sum(θRH[N] - θRH_\text{ave})^2}
\]

# \(\sqrt{}\): square root

- \(N\): Number of cycles
- \(θRH\): Angle at combustion mass rate N1 % (CA) (calculated value)
- \(θRH_\text{ave}\): Averaged angle at combustion mass rate N1 % (CA) (calculated value)

**90. θRH_cov**

Rate of change in angle at combustion mass rate N1 % (CA)

\[
θRH_\text{cov} = \frac{θRH_\text{std}}{θRH_\text{ave}} \times 100
\]

- \(θRH_\text{std}\): Standard deviation of angle at combustion mass rate N1 % (CA) (calculated value)
- \(θRH_\text{ave}\): Averaged angle at combustion mass rate N1 % (CA) (calculated value)

**91. θRH2[N]**

Crank angle at combustion mass rate N2 % (CA)

(related to the crank angle such that the combustion mass rate is N2 %)

\[
θRH2[N] = \text{floor}(\text{round}(RHθ \times 720, N)), \text{ratio2})
\]

# \(\text{floor}\): the angle whereby RHθ is greater than ratio2 (depending on the angular resolution)

# \(\text{round}\): round to 1 digit after the decimal place

- \(N\): Number of cycles
- \(RHθ\): Combustion mass rate (%) (calculated value)
- \(\text{ratio2}\): Ratio for judging angle of combustion mass rate N2 % (%) (manually input)

**92. θRH2_ave**

Averaged angle at combustion mass rate N2 % (CA)

\[
θRH2_\text{ave} = \frac{1}{N} \times \sum(θRH2[N])
\]

- \(N\): Number of cycles
- \(θRH2\): Angle at combustion mass rate N2 % (CA) (calculated value)

**93. θRH2_std**

Standard deviation of angle at combustion mass rate N2 % (CA)

\[
θRH2_\text{std} = \sqrt{\frac{1}{N - 1} \times \sum(θRH2[N] - θRH2_\text{ave})^2}
\]

# \(\sqrt{}\): square root

- \(N\): Number of cycles
- \(θRH2\): Angle at combustion mass rate N2 % (CA) (calculated value)
- \(θRH2_\text{ave}\): Averaged angle at combustion mass rate N2 % (CA) (calculated value)
94. \( \theta_{RH2\_cov} \)

Rate of change in angle at combustion mass rate N2 % (CA)

\[
\theta_{RH2\_cov} = \left( \frac{\theta_{RH2\_std}}{\theta_{RH2\_ave}} \right) \times 100
\]

\( \theta_{RH2\_std} \): Standard deviation of angle at combustion mass rate N2 % (CA) (calculated value)

\( \theta_{RH2\_ave} \): Averaged angle at combustion mass rate N2 % (CA) (calculated value)

95. \( \theta_{RH3[N]} \)

Crank angle at combustion mass rate N3 % (CA)

(the crank angle such that the combustion mass rate is N3 %)

\[
\theta_{RH3[N]} = \text{floor}(\text{round}(R\theta, [720, N]), \text{ratio}3)
\]

# floor: the angle whereby RH\( \theta \) is greater than ratio3 (depending on the angular resolution)

# round: round to 1 digit after the decimal place

\( N \): Number of cycles

\( R\theta \): Combustion mass rate (%) (calculated value)

\( \text{ratio}3 \): Ratio for judging angle of combustion mass rate N3 % (%) (manually input)

96. \( \theta_{RH3\_ave} \)

Averaged angle at combustion mass rate N3 % (CA)

\[
\theta_{RH3\_ave} = \left( \frac{1}{N} \right) \times \Sigma(\theta_{RH3[N]})
\]

\( N \): Number of cycles

\( \theta_{RH3} \): Angle at combustion mass rate N3 % (CA) (calculated value)

97. \( \theta_{RH3\_std} \)

Standard deviation of angle at combustion mass rate N3 % (CA)

\[
\theta_{RH3\_std} = \sqrt{\left( \frac{1}{N - 1} \right) \times \Sigma(\theta_{RH3[N]} - \theta_{RH3\_ave})^2}
\]

# \( \sqrt{\text{square root}} \)

\( N \): Number of cycles

\( \theta_{RH3} \): Angle at combustion mass rate N3 % (CA) (calculated value)

\( \theta_{RH3\_ave} \): Averaged angle at combustion mass rate N3 % (CA) (calculated value)

98. \( \theta_{RH3\_cov} \)

Rate of change in angle at combustion mass rate N3 % (CA)

\[
\theta_{RH3\_cov} = \left( \frac{\theta_{RH3\_std}}{\theta_{RH3\_ave}} \right) \times 100
\]

\( \theta_{RH3\_std} \): Standard deviation of angle at combustion mass rate N3 % (CA) (calculated value)

\( \theta_{RH3\_ave} \): Averaged angle at combustion mass rate N3 % (CA) (calculated value)

99. PolY\( \theta \) [720]

Polytropic index

\[
\text{PolY}\theta [720] = \left( \frac{\log_{10}(P\theta\ ave[n-1])}{\log_{10}(V\theta\ ave[n])} \right) / \log_{10}(V\theta\ [n-1] / V\theta\ [n])
\]

\( n = 0 \) to \( 719 \). when \( n = 0 \), PolY\( \theta = 1 \).

\( P\theta\ ave \): Average cylinder pressure (kPa)

\( V\theta \): Piston displacement (m\(^3\))
7.1 Explanation of Equations

100. Vmax

Maximum piston displacement (m³)

When Clearance volume is selected on the Parameter Settings screen
\[ V_{\text{max}} = V_{\text{st}} + V_{\text{c}} \]

When Compression ratio is selected on the Parameter Settings screen
\[ V_{\text{max}} = V_{\text{st}} + \left( \frac{V_{\text{st}}}{(C_r - 1)} \right) \]

\( V_{\text{st}} \): Piston displacement (m³)
\( V_{\text{c}} \): Clearance volume (m³)
\( C_r \): Compression ratio (manually input)

101. chXθ ave[720]

Other signals (crank angle graph data)
\[ \text{chXθ ave}[720] = \frac{1}{N} \times \sum(\text{chX}[720,N]) \]

\( N \): Number of cycles
\( \text{chX} \): Measured value of chX

102. chXave[N]

Other signals (cycle graph data)
\[ \text{chXave}[N] = \text{ave}(\text{chX}[720,N]) \quad \# \text{ ave: average value} \]

\( N \): Number of cycles
\( \text{chX} \): Measured value of chX

103. a_ave

Average start point of combustion (CA)
\[ a_{\text{ave}} = \frac{1}{N} \times \sum a[N] \]

\( N \): Number of cycles
\( a \): Crank angle (CA) at which the value of dQθ is changed to a positive value immediately before dQmax (calculated value)

When manually input, the setting value is assumed to be point “a.”

104. b_ave

Average end point of combustion (CA)
\[ b_{\text{ave}} = \frac{1}{N} \times \sum b[N] \]

\( N \): Number of cycles
\( b \): Crank angle (CA) at which the value of dQθ is changed to a negative value immediately after dQmax (calculated value)

When manually input, the setting value is assumed to be point “b.”
### 8.1 A List of Error Messages

<table>
<thead>
<tr>
<th>Messages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis results not saved. Save the results?</td>
<td>All calculated results will be discarded. OK to proceed?</td>
</tr>
<tr>
<td>Settings take effect after system restart.</td>
<td>No unit selected.</td>
</tr>
<tr>
<td>Illegal setting value.</td>
<td>The input value exceeded the upper or lower limit for the setting.</td>
</tr>
<tr>
<td>No Group ID was specified.</td>
<td>Failed to load the analysis conditions.</td>
</tr>
<tr>
<td>P1 channel assignment not set correctly.</td>
<td>The format of the analysis file (.ecp) is incorrect.</td>
</tr>
<tr>
<td>Application has already started. (Two simultaneous sessions prohibited.)</td>
<td>Cannot exit during monitoring. Please stop monitoring before exiting.</td>
</tr>
<tr>
<td>Unused channel cannot be assigned to a trigger.</td>
<td>The range defined by the start cycle and end cycle settings exceeds the number of effective cycles. Please reenter the values.</td>
</tr>
<tr>
<td>X axis range not entered correctly.</td>
<td>Y axis range not entered correctly.</td>
</tr>
<tr>
<td>Could not update network search settings.</td>
<td>Could not execute network search.</td>
</tr>
<tr>
<td>Could not acquire network information.</td>
<td>Please select a trigger type.</td>
</tr>
<tr>
<td>Please select a range.</td>
<td>Cannot start waveform check.</td>
</tr>
<tr>
<td>Cannot stop waveform check.</td>
<td>Cannot specify stroke type.</td>
</tr>
<tr>
<td>Cannot specify measurement information.</td>
<td>Cannot specify channel information.</td>
</tr>
<tr>
<td>Cannot specify trigger information.</td>
<td>Failed to create analysis work data.</td>
</tr>
<tr>
<td>Failed to acquire specified (ch/cycle) raw data.</td>
<td>Failed to acquire ASCII header information.</td>
</tr>
<tr>
<td>Failed to initialize calculation.</td>
<td>The default drive (*) may have insufficient free space.</td>
</tr>
<tr>
<td>Analysis results may not be able to be saved. OK to continue?</td>
<td>Start cycle cannot be greater than the end cycle.</td>
</tr>
<tr>
<td>Engine type different than during measurement. Force execution?</td>
<td>License is invalid.</td>
</tr>
<tr>
<td>The period of a trial is remaining XX days.</td>
<td>The license key information does not match the installation information.</td>
</tr>
<tr>
<td>The period of a trial had finished.</td>
<td>A license key is undetectable.</td>
</tr>
<tr>
<td>A license key is undetectable.</td>
<td>Please push &quot;Retry&quot; button after connecting a usb-license-key.</td>
</tr>
<tr>
<td>If the &quot;Cancel&quot; button is chosen, this software will be finished.</td>
<td>This firmware version of DL850 series is not supported.</td>
</tr>
<tr>
<td>The number of active channels exceeds the upper limit.</td>
<td>No more than 16 channels can be input.</td>
</tr>
</tbody>
</table>
## Appendix 1  Relationship between Number of Mounted Modules and Maximum Number of Measurable Cycles

The maximum number of measurable cycles varies as follows according to the set number of modules mounted in the DL850 series/SL1000 and the angular resolution setting.

<table>
<thead>
<tr>
<th>No. of modules</th>
<th>Max. measurable cycles</th>
<th>1 CA</th>
<th>0.5 CA</th>
<th>0.25 CA</th>
<th>0.1 CA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>2500</td>
<td>1250</td>
<td>625</td>
<td>250</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>2500</td>
<td>1250</td>
<td>625</td>
<td>250</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>1250</td>
<td>625</td>
<td>312.5</td>
<td>125</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>1250</td>
<td>625</td>
<td>312.5</td>
<td>125</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>625</td>
<td>312.5</td>
<td>1562</td>
<td>625</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>625</td>
<td>312.5</td>
<td>1562</td>
<td>625</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>625</td>
<td>312.5</td>
<td>1562</td>
<td>625</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>625</td>
<td>312.5</td>
<td>1562</td>
<td>625</td>
</tr>
</tbody>
</table>
## Appendix 2  Supported Modules

<table>
<thead>
<tr>
<th>MODEL</th>
<th>Name</th>
<th>What are supported*</th>
</tr>
</thead>
<tbody>
<tr>
<td>720210</td>
<td>High-Speed 100 MS/s, 12-Bit Isolation Module</td>
<td>△</td>
</tr>
<tr>
<td>720211</td>
<td>High-Speed 100 MS/s, 12-Bit Isolation Module</td>
<td>△</td>
</tr>
<tr>
<td>720220</td>
<td>16-CH Voltage Input Module</td>
<td>×</td>
</tr>
<tr>
<td>720221</td>
<td>16-CH Temperature/Voltage Input Module</td>
<td>×</td>
</tr>
<tr>
<td>720230</td>
<td>Logic Input Module</td>
<td>×</td>
</tr>
<tr>
<td>720240</td>
<td>CAN Bus Monitor Module</td>
<td>×</td>
</tr>
<tr>
<td>720241</td>
<td>CAN &amp; LIN Bus Monitor Module</td>
<td>×</td>
</tr>
<tr>
<td>720242</td>
<td>CAN/CAN FD Monitor Module</td>
<td>×</td>
</tr>
<tr>
<td>720243</td>
<td>SENT Monitor Module</td>
<td>×</td>
</tr>
<tr>
<td>720250</td>
<td>High-Speed 10 MS/s, 12-Bit Isolation Module</td>
<td>△</td>
</tr>
<tr>
<td>720254</td>
<td>4-CH 1MS/s, 16-Bit Isolation Module</td>
<td>×</td>
</tr>
<tr>
<td>720266</td>
<td>Temperature, High Precision Voltage Isolation Module (low noise)</td>
<td>△</td>
</tr>
<tr>
<td>720268</td>
<td>High-Voltage 1 MS/s, 16-Bit Isolation Module (with AAF, RMS)</td>
<td>△</td>
</tr>
<tr>
<td>720281</td>
<td>Frequency Module</td>
<td>△</td>
</tr>
<tr>
<td>701250</td>
<td>High-Speed 10 MS/s, 12-Bit Isolation Module</td>
<td>△</td>
</tr>
<tr>
<td>701251</td>
<td>High-Speed High-Resolution 1 MS/s, 16-Bit Isolation Module</td>
<td>○</td>
</tr>
<tr>
<td>701255</td>
<td>High-Speed 10 MS/s, 12-Bit Non-Isolation Module</td>
<td>△</td>
</tr>
<tr>
<td>701260</td>
<td>High-Voltage 100 kS/s, 16-Bit Isolation Module (with RMS)</td>
<td>△</td>
</tr>
<tr>
<td>701261</td>
<td>Universal (Voltage/Temp.) Module</td>
<td>○</td>
</tr>
<tr>
<td>701262</td>
<td>Universal (Voltage/Temp.) Module (with AAF)</td>
<td>○</td>
</tr>
<tr>
<td>701265</td>
<td>Temperature, High Precision Voltage Isolation Module</td>
<td>△</td>
</tr>
<tr>
<td>701267</td>
<td>High-Voltage 100 kS/s, 16-Bit Isolation Module (with RMS)</td>
<td>△</td>
</tr>
<tr>
<td>701270</td>
<td>Strain Module (NDIS)</td>
<td>△</td>
</tr>
<tr>
<td>701271</td>
<td>Strain Module (DSUB, Shunt-Cal)</td>
<td>△</td>
</tr>
<tr>
<td>701275</td>
<td>Acceleration/Voltage Module (with AAF)</td>
<td>△</td>
</tr>
<tr>
<td>701280</td>
<td>Frequency Module</td>
<td>△</td>
</tr>
<tr>
<td>701281</td>
<td>Frequency Module</td>
<td>△</td>
</tr>
</tbody>
</table>

The table above includes discontinued modules. When making a purchase, check whether the module you want is available with your nearest YOKOGAWA dealer. You can also check the information on the YOKOGAWA Web page.

https://tmi.yokogawa.com/solutions/products/

*What are supported*

〇: Conditions can be set from the Combustion Pressure Analysis software.

△: Conditions cannot be set from the Combustion Pressure Analysis software.

Measurement is possible using the measurement conditions set on the DL850 series or SL1000.

×: The module is not supported. Do not install into the DL850 series.

- For a multi-cylinder engine, apply the cylinder pressure signals to consecutive channels starting with CH1.
- On the DL850 series, install the measurement modules consecutively from the first slot, without empty slots in the middle.
Appendix 3  Frequently Asked Questions (FAQ)

This section provides answers to questions frequently asked by users.

**Does scaling need to be set on the measuring instrument?**

Conversion to physical values is possible on the DL850 series and SL1000, but conversion is performed on the Combustion Pressure Analysis Software. As such, use the instrument with scaling set to off.

**Is it okay to assign labels to the input channels of the measuring instrument?**

Channel labels can be assigned on the DL850 series and SL1000, but because the Combustion Pressure Analysis Software searches for default channel labels, do not assign channel labels.

**The USB license key for the software has been misplaced. Can it be reissued?**

The USB license key cannot be reissued even if it is lost. Be careful not to lose it.
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
<th>show wizard upon startup</th>
<th>3-8</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td></td>
<td>manuel input data item</td>
<td>2-9, 6-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>manual trigger</td>
<td>4-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>maximum cylinder pressure</td>
<td>7-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>maximum number of measurable cycles</td>
<td>App-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>maximum rate of cylinder pressure rise</td>
<td>7-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measured data</td>
<td>3-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measurement condition</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measurement condition setting</td>
<td>2-3, 4-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measurement function</td>
<td>2-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measuring instrument</td>
<td>5-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>message</td>
<td>8-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>method of absolute pressure correction</td>
<td>2-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>minimum value of IMEP</td>
<td>2-10, 3-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>monitor function</td>
<td>2-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>monitor item</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>monitor screen</td>
<td>3-2</td>
</tr>
<tr>
<td>N</td>
<td></td>
<td>NMEP</td>
<td>7-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No. of effective cycle</td>
<td>5-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>number of cylinders to acquire/save</td>
<td>2-3, 4-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>number of cylinder</td>
<td>4-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>number of engine cylinder</td>
<td>5-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>numeric analysis data item</td>
<td>2-10, 3-5</td>
</tr>
<tr>
<td>O</td>
<td></td>
<td>open</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>other signal</td>
<td>2-5, 2-7, 2-8</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td>parameter</td>
<td>4-13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>parameter setting</td>
<td>2-3, 2-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PC system requirement</td>
<td>1-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>perform calculation</td>
<td>2-11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>piston displacement</td>
<td>7-3, 7-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PMEP</td>
<td>7-11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>probe information</td>
<td>4-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>progress bar</td>
<td>4-20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pumping loss</td>
<td>7-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P-V graph</td>
<td>2-9</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>range</td>
<td>4-10, 4-11, 4-12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of change in IMEP</td>
<td>7-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of change in maximum cylinder pressure</td>
<td>7-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of change in maximum cylinder pressure rise</td>
<td>7-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of change in NMEP</td>
<td>7-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of change in PMEP</td>
<td>7-11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of cylinder pressure</td>
<td>7-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of misfire</td>
<td>7-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rate of piston displacement increase</td>
<td>7-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>raw data</td>
<td>4-16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RJC</td>
<td>4-11, 4-12</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>save analysis condition</td>
<td>5-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>save analysis data</td>
<td>2-11, 5-11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>save measured data</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>select monitor item</td>
<td>4-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup screen</td>
<td>4-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup setting</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup wizard</td>
<td>4-1</td>
</tr>
<tr>
<td>T</td>
<td></td>
<td>TC unit</td>
<td>4-11, 4-12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TDC correction</td>
<td>2-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TDC correction and calibration factor</td>
<td>4-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TDC correction and calibration factor settings</td>
<td>2-3, 2-5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>test information</td>
<td>5-11, 6-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>toolbar</td>
<td>3-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>trigger condition</td>
<td>4-9</td>
</tr>
<tr>
<td>V</td>
<td></td>
<td>voltage data</td>
<td>4-16</td>
</tr>
<tr>
<td>W</td>
<td></td>
<td>window operation</td>
<td>3-7</td>
</tr>
</tbody>
</table>